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CHAPTER 1 — INE IGHT CHANGE
OVERV IEW

Change is where you can manage the living history of your changes, their associated costs, and convert
them into change orders, as necessary, when working with both the owner and subcontractors. As
issues arise, project engineers record and submit issues, get them approved through the client and
execute change orders.

The concept of project related changes is one of the most difficult entities to track on a project. Most
projects run into many kinds of issues during the contract lifecycle. Those projects that don’t utilize
InEight Change will usually track project progress in an Excel sheet, or alternate software.

The Change tool provides a consistent, thorough way to manage your changes. It replaces your change
tracking spreadsheet with a thorough and flexible change order management process.

The Change module follows the following workflow:

1.0.1 Change Overview

When the Change workflow is activated in Project Settings, you will see that the Change register
contains rows and columns like a spreadsheet and consists of tabs that further break down the
different stages on an issue.
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The principal focus within Change is the concept of creating, approving and tracking of issues and
change orders. As new issues come up within the contract lifecycle, Change is where you can collect
your Issues, convert them into Potential Change Orders (PCOs) and Client Change Orders (CCOs).

Each issue has the capacity to track the information necessary for any legal action or related
documentation. Some of the information you can capture to track an issue are:

l Issue name and full description
l When the issue started
l The source/cause of the issue (a field condition, client instruction, etc.)
l The scope of the issue (out of scope, in scope, contingency, etc.)
l Confirmation of notifying the client

1.0.1 .1 Who uses Change?

The primary users of Change differ from the typical roles that use the rest of InEight cloud platform,
namely Contract Managers and Contract Administrators. In other words, the main users of Change are
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typically the same as Contract. These are employees focused on contract and change management as
their primary role.

Page 18 of 257 InEight Inc.  |  Release 25.9

Change User Guide



CHAPTER 2 — PROJECT SETUP

To manage issues and change orders successfully, the correct Change settings must be set up before
project initiation. Some settings differ between the organization and project levels.
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2 . 1 ORGAN IZAT ION SETT INGS

Prior to initiation, the organization and project settings are significant to successfully manage a project
in Change.

Organization settings are distinct from the project settings since they are defined by the administrative
level in your organization. The image below shows you how to access organization settings from the
main menu.
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2.1.1 Customizable Revenue Categories

Revenue categories and probability percentages are customizable within each organization through
master data by manual entry or API. This customization has specific permissions around edits.

The Revenue category and Probability percentage in the Issue, PCO and CCO Logs pull data dynamically
from master data.

Revenue categories are located in your organization’s Master data libraries. From the Main menu,
selectMaster data libraries and then Revenue categories.

When you land on the organization settings page, select Change from the left navigation. This opens
the Change organization settings.

On the Revenue categories page, you can add new revenue categories or edit existing ones as well as,
set revenue categories to be Active or Inactive.
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Use permissions to control who can view, add, or edit revenue categories.

By default, the Executed change order revenue category is always present. This is the default
status in all logs when an issue, PCO, or CCO is executed.

An example would be to tag a Potential entitlement, which is a $100,000 change order. Organizations
would set the categories and probabilities percentages based on their organization's business rules.
Customizable per tenant and at the Change level, you can assign the revenue category to the PCO,
CCO, or issue you want.

These categories are used by InEight Control for revenue projections. These are required in Change and
Control. Association is done between the probability percentage, revenue category and revenue
change status.
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After selections are done, such as Highly Probable, the Probability percentage pulls from the Master
data. It is then pushed to Control.

2.1.1 .1 Access ing Pro jec t Deta i ls

Project details can be accessed at the organization level in Settings > Edit project. Project details
provides all the information for the project.
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2.1.1 .2 Access ing Organizat ion Level Set t ings

After you open the organization settings page, select the Change icon from the left navigation. You can
use the expansion arrows to see the application names. This opens the Change organization settings.
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2 . 2 CONF IGURAT IONS

Change has organization settings to further configure the product for your organization. To see this
setting, go to organization settings, then select Change > Configurations. The settings that are
configurable at both the organization and project levels are:

l ID customization
l Change condition
l Pricing configuration
l Custom lists
l General status
l Pricing status
l Proposal status
l Responsible party
l Scope
l Source/cause
l Task type setup
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You can manage and customize configurations according to your organization. You can also add to the
list. Each configuration set up at the organization level flows down to the project level where further
customization is available.

For Scope, status is configurable at the organization level. This lets you add and maintain scope
definitions that are unique to your organization. Because scopes are custom, Change does not validate
the scope when closing an issue.

These changes will be reflected in the project as drop-down lists.
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Pricing and Proposal status list items for issues, PCOs and CCOs. When you select the Pricing status
type on the left side of Pricing or Proposal status pages, you can add Change condition and Source or
cause list items only for issues.
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2 . 3 CUSTOM L ISTS

The Custom list setting (organization Settings > Configurations > Custom lists) lets your organization
configure default lists that automatically populate custom drop-down list fields for projects. You can
configure two custom lists each for issues, PCOs, and CCOs.

You can customize the name of the fields using the Custom labels settings. Use the Active toggle to
indicate whether the list item is active. When the value is active it is available in lists. If it is inactive,
the value is not available for use in future issues, PCOs, and CCOs but is maintained where it was
previously used.

After a custom list has been used you cannot delete it from the organization settings unless you delete
it from all items. You also can inactivate a custom list, so it is not available for future use.

Custom lists set at the organization level are applied to the project level and default to Active.
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2 . 4 PR IC ING CONF IGURAT ION

Use the Pricing configuration page (organization Settings > Configurations > Pricing configuration) to
restrict the ability to modify the executed contract amount during the execution of a client change
order.

When you disable Allow users to edit the Executed change order amount upon execution toggle at the
organization level, the setting at the project level is also disabled. When you enable the setting at the
organization level, you can enable or disable the setting for each project.

2 . 5 ID CUSTOMIZAT ION

Change lets you customize your PCO and CCO numbering schemes to ensure consistent numbering.
Configuration settings at the organization and project levels let you specify whether to generate PCO
and CCO IDs sequentially, and if so, a prefix and starting number.

You can configure customized IDs using the ID customization configuration list (Organization >Settings
> Configurations > ID customization). You can set up numbering for PCOs and CCOs separately.
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The Generate PCO/CCO IDs sequentially settings indicate whether Change generates numbers
sequentially. When set to No, you enter any number as the ID when you create the PCO or CCO. When
set to Yes, you can specify a prefix and a starting number that Change uses when it automatically
generates the PCO or CCO ID.

The Prefix and Starting number fields are enabled only when the Generate Potential change
order/Client change order IDs sequentially toggle is set to Yes. The prefix on the PCO or CCO is added
to the ID in the exact way it is entered in the field. If you want a space between the prefix and the
starting number, you must enter it in Prefix field. You can edit the starting number until a PCO or CCO
has been created. After that, the field is disabled.

The Allow projects to edit settings check box specifies whether you can override the settings at the
project level. When checked, the organization-level settings are the default at the project level, but the
project administrator has the ability to override the settings. When the check box is checked, the
numbering scheme is enforced at the project level. After you establish a starting number, and the first
PCO or CCO is created, you cannot change the starting number at the project level.

2 . 6 TASK TYPE SETUP

Use the Task type set up page (organization Settings > Configurations > Task type setup) to select the
InEight Compliance registered task template to use when creating tasks in an issue, PCO, or CCO. The
template is used for all projects in the organization.

Refer to the Compliance topics for information about setting up templates.

2 . 7 WORKFLOW ASS IGNMENTS

The Workflow Assignments tab lets you set up approval processes for budget moves, potential change
orders, client change orders, and documents. The settings include defining the number of steps in your
approval processes and making assignments of who approves each step.
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You can set up dollar-value thresholds based on contract type at an organization level for PCOs or
CCOs. The organization has an approval matrix where any dollar amount over the threshold set must
be approved. Approval for budget moves and document approvals have ordered steps assigned to
roles.

Add a workflow assignment threshold

Summary: Add a workflow assignment threshold to set the amount at which a PCO or CCO must be
approved.

Considerations: The workflow steps set at the organization level are performed after those set at the
PCO/CCO and project levels. However, if the value of the PCO or CCO is below the organization level
thresholds, the workflow thresholds set at the organization level will not show in the Workflow
Assignments.

Thresholds are absolute values, so a pricing change in either direction starts the approval workflow.

Quick steps:

1. Go to the Workflow Assignments tab.

2. Select the PCO approval setup or CCO approval setup tab.

3. Click the Add approval icon.

4. In the Add approval slide-out panel, enter the threshold amount and approval step title.

5. Indicate whether projects must select specific users based on assigned roles. When the check
box is selected, the project must add a user who has that role to that step before workflow can
be started. If the check box is not selected, all users in that role are eligible for approval.

6. Enter the roles for the Assign approval roles.

7. Click Add to complete.

8. If you want the approval workflow for the threshold to have additional steps, click Add another
step. To change the position of a step, select it, and then use the up and down arrows to the
right of the steps to move up or down.

Organization-level thresholds cascade to every PCO or CCO. You can add additional steps at the project
level, which are performed before the steps set at the organization level. You can add additional
approval steps at the individual PCO or CCO level, which, regardless of the value of the PCO or CCO, are
always first.
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Add a budget move approval workflow

Summary: Add a budget move approval workflow when you want the budget move to be approved
before being sent as a draft to InEight Control.

Considerations: When there is a workflow in place, the budget move is not sent to Control until it has
been approved in Change.

Quick steps:

1. From the organization Settings >Workflow assignments tab, select the Budget move approval
setup subtab.

2. Click the Add approval icon. The Add approval slide-out panel opens.

3. Enter the step title and the approver roles.

4. Indicate whether projects must select specific users based on assigned roles. When the check
box is selected, the project must add a user who has that role to that step before workflow can
be started. If the check box is not selected, all users in that role are eligible for approval.

5. Click Add.

6. Repeat steps 2-5 for each step you want to add.

7. Click Save.

What's next: You can add steps at the project level.

2 . 8 CHANGE TEMPLATES

Much like Contract writer, Change writer is a customized contract document writer intended for a
vendor or subcontractor to eventually agree to, accept, or reject.

As an issue turns into a PCO, and a PCO to the client might turn into a CCO, the document associated
with the CCO must be signed by all parties for legal reasons.

Change writer can create project specific change documents such as issue summary documents, PCOs
or CCOs through Microsoft Word or Microsoft Excel templates and tags. This helps you create
customized client change order documents. If there is a need to create a customized change contract
for a client, Change provides Change writer to aid in the area. This is a legal document that is intended
to be signed by all parties and stakeholders.
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2.8.0 .1

2 . 9 TEMPLATES SUBTAB

The templates subtab shows the templates register and gives you the tools you need to start building
templates.

You can download a sample template that will help you get started with your template. You can also
get a list of general tags and collection table tags to be used in the template. After you have opened
the list, you can export the tags to a Microsoft Excel spreadsheet.

2.9.1 Download a sample template

You can download a sample template in Microsoft Word and Microsoft Excel formats. The samples
show how a contract could look in either format. This feature is available at both the organization and
project levels.

To download a sample template, click the Download sample template icon on the template register,
and then select either Download Word template or Download Excel template.

2.9.2 Creating a change order template

To create a template for your change order documentation, you will use predefined change writer tags
to auto-fill your change document with the information from your contract. From the Add change
template record, you can select the View available tags icon and choose General tags to open the list
of general tags that can be used in the body of the template only. Select Collection table tags to see
the list of tags that can be used in collection tables. General tags cannot be used in a collection table.
After you have opened the list, you can export the tags to an Excel spreadsheet.

The Location source shows the name of the page that Change pulls the information from when
building the template. You can see an example of how this information might look in the change order
in the Example column. The Applicable for column shows the type of template for which the tags are
valid.
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Refer to the instructions on the Instructions tab of the Excel file for information about using tags and
building a template.

2 . 10 TEMPLATE CONTACT TAGS

Template contact tags are general tags that correspond to fields in the project Assigned contacts
(project > Assigned contacts). Tags let you select contact details to populate information in a
generated document. For example, you could select a specific contact name for the greeting in a cover
letter or notification letter.

The tags show in the general tags list as <<Template contact: field>>, where field corresponds to a field
in the project contacts. The tags can be used to customize documents when you use standard or bulk
template generation. See 5.9 Standard and bulk template processing on page 236 for information
about standard and bulk template generation.

When the Change writer detects a template contact tag, it retrieves the information for the selected
contact from the project's contacts. When you use the tags with Standard template processing, you
can select one contact in the Select contacts step of the Change document wizard. When you use the
tags with bulk template processing, you can select up to 10 contacts, and a separate document is
generated for each contact.

Page 34 of 257 InEight Inc.  |  Release 25.9

2.10 Template contact tags Change User Guide



2 . 11 MA INTA IN F IELD FORMATT ING

Large text box fields, such as Issue description, PCO and CCO description of change, and PCO and CCO
contract term fields, contain formatting tools that let you use boldface type, numbered or bulleted
lists, and other text formats. To preserve this formatting in Microsoft Word templates, you can insert a
Word merge field instead of a tag for the field.

To insert a merge field in a Word template, position the cursor, and then go to Insert > Quick parts >
Field. From the Field dialog box, select MergeField, and then enter the tag name without the brackets
in the Field Properties > Field name field (for example, CCO contract term 1). When a document is
generated, Word uses the formatting from the field to format the text.

Refer to the Instructions in the Change templates tags spreadsheet for more information about merge
tags.

2 . 12 DOCUS IGN TAGS

DocuSign eSignature tags for recipients let you embed signee information to pull into your organization
or project templates. DocuSign tags used in a template are read when sending a document for
signature.

The DocuSign tags serve as placeholders for the eSignatures. Change's DocuSign tags also include tags
that serve as placeholders for text boxes, check boxes, drop-down lists, and radio buttons that are
added by the document sender in the DocuSign Sender view. These tags are available for eSign 1-10
and for each project contact. When you add the tags in the template, you ensure that the
corresponding item is consistently placed. For text and drop-down lists, you only place one tag in the
template. For check boxes, you place one tag for each option. For radio buttons, a single tag places two
buttons in the document. You can add more radio button tags for additional buttons.

When a document with these tags is opened in the DocuSign Sender view, the tags are present, but
they do not have values. You can add the values from the Sender view. For example, if the template
has three check box tags, when the document is opened in DocuSign, three empty check boxes are
shown. You then add the value for each check box in DocuSign.

Refer to the instructions on the Instructions tab of the Excel file for information about DocuSign tags.

2 . 13 TEMPLATE TYPES

Change templates are classified by the template type. This classification can help you ensure that the
template suits your business needs based on the purpose of the template. Change supports the
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following template types:

l Client change order
l Potential change order
l Issue

The template type indicates which general tags and collection tags are valid for the template. For
example, a client change order template can use the tags that are applicable for client change order
templates. Any template can use the tags with the type All templates. The template tags are validated
when you attach a template file to the template.

If you have invalid tags, the Template file section of the Details page shows a message that there are
validation errors. You must go into the Word or Excel template and fix the errors. You cannot publish
the template if there are any errors.

2 . 14 TEMPLATE LANGUAGE

You can define the language in which the contract template is generated using the Select template
language field in the Change template details. Selecting a template language lessens the tags available.
For example, if you select Spanish as the template language, you can use only Spanish tags in the
template even if the language of your application is English. Upon generation, template and tags are
generated in Spanish.

You cannot use tags in multiple languages in a single template. During template validation, the
application only searches the tags of the selected language instead of all languages.

2 . 15 COLLECT ION TABLES

You can add multiple items to a vendor, supporting documents, associations, or workflow approvals
section of a template by using a collection table. You can create collection tables in Word or Excel that
include those items and place them into the template.

A collection table contains collection tags specific to a template type. General tags cannot be used in a
collection table. The Change writer searches the information in the Change application and returns the
values in the table. Collection tags are specific to the template type. A collection table can have tags for
one table type only, but a template can have multiple tables. For example, a Potential Change Order
template type can have tables for vendors and supporting documents, but the tables can include only
the tags for its table type. The vendors table can have only the tags for the Vendors table type, and the
supporting documents table can have only the tags for the Supporting documents table type.
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Add a collection table to a template

To add a collection table to a template:

1. Download the collection tags spreadsheet (list) and follow the instructions on the Instructions
tab.

2. Open or create a new template in Word or Excel. Keep in mind the template type (issue,
potential change order, or client change order).

3. Create a table in the document or spreadsheet.

4. Enter headers, if applicable, and format the table to suit your business needs.

5. Enter a tag in each column. The tag can be from one table type only.

6. Save your document.

What's next: Upload the template to Change. See Build your template for more information.

Collection tags do not show up on the Review templates page. If you have a template that has
only collection tags you see the message No general tags found in this template in the review
area. You can see collection tags in the preview. If there is an error you must fix it in the Word
or Excel document. If a field is missing, you must go to the contract and fix that item.

2 . 16 T IPS FOR US ING TEMPLATE TAGS

2.16.0 .1 T ips for us ing template tags

Template tags are the building blocks of a Change document. The tags pull information from the
corresponding data fields in the issue, PCO, or CCO detail to populate the document, except for Sum of
pay items original price and Sum of pay items current price, which pull information from fields in
InEight Control. Use the following guidelines when you are adding tags to your template.

Additional instructions can be found in the tags export.

Genera l tag in format ion

l General tags cannot be used in a table.

l Equations are discarded in document generation. No tags in an equation are read.
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l Some fields in the application have their own formatting that is applied in the template (for
example, a bullet list). The general tags associated with those fields use the application's
formatting, and you do not have to enter additional formatting in the template.

Col lec t ion tab le tags

l Only collection table tags can be used in a collection table.

l Tags cannot be read from nested tables, such as a table within a table.

l Tags for the Pricing summary collection table gather the information from the pricing summary
page for an issue, PCO, or CCO and places them in the collection table. If a PCO has multiple
issues or a CCO has multiple issues or PCOs, the collection table shows each issue or PCO on a
separate line. When a markup is applied to multiple issues, each markup shows on a separate
line.

DocuSign tags

l Change the color of DocuSign tags to white, otherwise the tags show in the document. The white
text matches the background and hides the tag.

l When adding a DocuSign tag to an Excel template, the column or row must be large enough for
the entire tag name. When the Excel file is converted to a PDF to send to DocuSign, the system
cannot read the tag if the whole tag name was not visible in Excel.

Microsof t Word documents

l Any text formatted in Change on the Details pages are retained in Word documents.

l The pricing summary tags for issue, PCO, and CCO generates all pricing details generate in the
Times New Roman font. The tag always generates as a preformatted table.

Microsof t Exce l documents

l For large text cells where you can format text, the formatting is converted to plain text.

l Any text formatted in Change on the Details pages are converted to plain text in Excel.

l Only the first sheet in an Excel template is read and tag information inserted. To generate
multiple Excel sheets, create multiple Excel files and merge them into a single PDF.

l The Change writer discards text boxes, word art, drawings, equations and formulas inserted into
an Excel document.
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l Tags cannot be used in calculations.

l The Pricing summary tags are not valid in Excel.

2 . 17 BU ILD YOUR TEMPLATE

After the Excel file opens from the download, you can copy the tags you need into a Word or Excel
version of your change order document, inserting them in the header, footer, and body of your change
documents. Refer to the Instructions tab of the Excel file for information about using tags and building
a template.

A sample Word template is provided for you as an existing template record on the Details Template
page.

You access this template by either the Organization level settings or Project level settings. Click the
Download sample templateicon, and then select Download Word template or Download Excel
template to access the download sample template in Word or Excel, respectively.
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Tags must be inserted exactly as they appear in Tag Name. After all tags are inserted into the
Change-related Microsoft Word document, save it as a .docx file. Change writer template can be
named the same at the Organization level as those in the Project level. Below is an example of a
document with the tags inserted. Everything in yellow are the highlighted tags.

Name the template and save it as an MS Word (.docx) document.

Returning to the Change template register, select the Add  icon to create a new Change template.
This opens the Change template details page.
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Item
Number Name Definition

1 Preview with
sample data

Opens a preview of your template using the default sample data.

2 Create new
version

Creates a new version of the template. This feature lets you update
the version of a template rather than inactivating it and then creating
a new one.

3 Control
buttons

Lets you to cancel the template creation, save and publish or only
save to access later.

4 Detail area Lets you name the template, specify the template type and
language, and add a description of the template.

5 Tags and
sample
template

Area where you can view and download the general or collection
table tags.

6 Template
file

Attach the template file which was created with the downloaded
tags.

7 Attributes Lets you add one or more market attributes that provide additional
ways to filter templates. Organization-level templates associated to
markets are automatically switched to On for Project use on any
project with the same market listed in the Project details. When a
market is added to the project details, the templates with the
associated market are enabled for the project.

8 Advanced
options

When Change detects a cost item pricing collection table in the
uploaded template, the Advanced option section shows. This
section lets you select how you want data to be grouped in the cost
item pricing table in the generated document. You can select a field
and the columns you want subtotaled in each section. See Cost item
pricing table grouping for more information.

Overview – Contract template Details
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New templates appear in the Change templates list in both Organization settings and Project settings.

2.17.1 Cost item pricing table grouping

After you upload a template to the Template details page, Change detects the cost item pricing
collection table and then shows the Advanced options section.

You can then select the field you want to group entries by using the Group by tag drop-down list. If you
want to show subtotals for the group, click Select subtotals. The Select subtotal options dialog box
opens showing all field tags that can be subtotaled. Use the arrows to move the fields between the
Available subtotals and Selected subtotals list as necessary.
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When you generate the Change document, the cost item pricing table shows the data in the specified
group. Subtotals within the group are also calculated.

2.17.2 Template versions

When you update templates with additional information, you can create a new version of the template
instead of deactivating it. The Create new version button is enabled when you edit a template.

When you create a new version, the version numbering starts after the previous version. The new
template version starts in the draft state. You can edit any of the fields except the template type and
language. You can then attach the new file. Only one draft version can exist for a template at a time.

Only one version of a template can be active at a time. After you publish a new version, the previous
version becomes inactive and is removed from the Templates register.

The Version column of the Templates register lets you see the template version number. When you
click the version number, the template version history is shown. The template names are linked to the
Template details page, so you can quickly view the detail information.
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The Version history subtab contains links to previous versions of a template. The version history shows
all versions in descending order, including inactive versions.

Versions of organization-level templates are available for use at the project level, but you can only
create a new version of those templates at the organization level.

Build a Change Template

1. From the Organization settings page, select Change Templates.

2. Click the View available tags icon, and then select General tags to view the tags.
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l The Change writer tags document opens.

3. Select the Export tag list icon to export it to your hard drive as an Excel file.

4. Save the exported file.

5. Open the Excel file you just saved. The value in the Applicable for column indicates the template
type that can use the tag.
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6. Copy and paste the tags into the Word or Excel document you are creating as your new Change
document.

l Tags must be inserted exactly as they appear in Tag name column.
l A template can use tags that are applicable to one template type plus the tags that
are applicable to all templates.

When adding tags for DocuSign, change the font color to white, so the tag name does not
show in the generated document.

7. If needed, you can insert one or more collection tables that are applicable to the template type.
Refer to Collection tables for information about building a collection table.

8. After all tags are inserted into the Word or Excel document, name the new template as
[your initials] – contract template.

9. Save it as a Word (.docx) or Excel (.xlsx) file.

l Below is an example of a document with inserted tags
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10. Return to the Change templates tab, and then select the Add template icon.

11. In the Add a new template dialogue, fill in the fields with the following:

l Template name: Use the name you named your template
l Description: Test contract template

12. Under the Template file section, select No template file attached.
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13. Find and select the change template you want to add.

14. If the template contains a cost item pricing collection table, the Advanced options section
shows on the Template details page. You can optionally select a field from the Group by
tag field list to specify grouping. If you want items subtotaled, click Select subtotals, and
then select the columns to subtotal.

15. After the contract template is uploaded, click Add.

16. A validation notice is shown.

l If the document was not validated, select the not validated link to view the errors, fix
the errors in your Word document, save, and publish again.

The file can be closed and published with invalid tags. During change order generation,
invalid tags are not replaced with contract data. The invalid tag displays in the generated
contract as it was inserted.

17. Click Save.
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l To check the formatting of the change document, click Preview with sample data. A
preview document opens in a separate window, which uses sample data from the tag
list. After you have viewed the sample, click Close. If you need to make changes to
the document, you can update the source and reattach it.

18. Click Save and Publish.

Item
number Name Definition

1 Template The name you gave as the changed template.

2 Description The description you used when creating the template.

3 Status The status of the template after created. The status will show
Draft, Published or Saved.

4 Template type The type of change document that can use the template.
Valid types are Client change order, Potential change order,
Issue, and Other.

5 Template file Name of the file which was uploaded into the contract writer.

6 Created date Date that the contract template was created.

7 Created by Name of person who created the template.

8 Modified date Date that the last modifications were made to the template.

9 Modified by Name of the person who made the last modification to the
template.

10 Template language The language of the tags in the template.
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2 . 18 TEMPLATE SETT INGS SUBTAB

Template settings let you configure characteristics for each template type at the organization level.
The Template settings subtab (Settings > Change templates > Template settings) contains controls for
editing, watermark stamps, and PDF output.

Item
number Name Definition

1 Allow users to
edit the
document
during
generation

Indicates whether users can edit the contract document when it is
in the review stage. When set to Yes, a user can edit the contract
document from the Review templates dialog box. When set to No,
the contract document cannot be edited from the dialog box, and
the user must edit contract information in Contract.

2 Require a
watermark
stamp upon
document
generation

Indicates whether to apply a watermark stamp when the document
is generated. When set to Yes the watermark is applied to the
document, but is removed after the document has been approved.
You can configure the watermark text and settings in the
Watermark stamp section of this page. When set to No, the
contract document does not have a watermark.

3 Output as
PDF only

Indicates whether you can only generate a PDF when you create a
contract document. When set to Yes, you cannot generate a
Microsoft Word or Excel document or make changes to the
contract files individually.
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Item
number Name Definition

4 End
watermark
requirement
event

Indicates the change order approval event that must occur before
the watermark stamp is no longer required for this template type.
For example, if you set the End watermark event field to CCO
approval, the watermark is no longer required after the CCO is
approved.
You can also indicate that the watermark stamp is always required
regardless of the change order approval event.
The watermark is removed from the generated document when
the document is approved. This field is enabled only when the
Require watermark stamp upon document generation toggle is set
to Yes.

Because a change document might have templates defined at the issue, PCO, and CCO levels, Change
uses the following conditions to determine which setting has precedence when there is a difference in
settings:

l If the Allow users to edit the document during generation toggle is set to No for any of the
templates, Change gives precedence to that setting, and no editing is allowed for any template.

l If the Require watermark stamp upon document generation toggle is set to Yes for any of the
templates, Change gives precedence to that setting, and a watermark is required for all
templates.

l If the Output as PDF only toggle is set to Yes for any of the templates, Change gives precedence
to that setting, and only PDF output is available for all templates.

The Watermark stamp section lets you define watermark text and layout for the Select watermark
stamp drop-down list in the Change writer. You can define the text for all languages used in your
templates. The language of the watermark matches the language of the template.

The watermark requirement events that are available vary by template type. The options are as
follows:

Template type Available end watermark events

Issue Always required

PCO Always required
PCO approval
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Template type Available end watermark events

CCO Always required
CCO approval
CCO execution

Other Always required

2 . 19 CHANGE CUSTOM LABELS

Change has settings that let you customize field names in the application to align with your business
terminology. You can customize the following fields in all languages supported in the InEight product.

l Allowance category
l Change condition
l Change order
l Client
l Client change order
l CCO
l CO
l Issue
l Potential change order
l PCO
l Scope
l Source/cause
l Vendor
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You can enter the label text for each of the fields in each language. The custom text replaces the
default text in field names, tab names, messages, templates, and other labels throughout the system.

The Enable custom labels toggle lets you switch between using your custom labels and Change's
default labels. When switched on, Change uses the defined labels in all languages. If you have not
defined a label, Change uses the default text for that field. When off, Change uses the default labels for
all fields in all languages. You can refer to the Change Custom Labels tab in Project settings as a legend
showing the custom labels and how they are referred to in tags and in the Change user interface.

When custom labels enabled at the organization level do not apply to your project, you can switch the
Enable custom labels toggle in the project settings to Off. When custom labels are disabled at the
organization level, you must use the default labels for all projects.

2 . 20 CHANGE PROJECT SETT INGS

Prior to initiation, it is important to check the project settings to successfully manage a project within
Change. Project settings are distinct from organization settings, which are defined by the
administrative level of your organization. The image below shows how to get to the project settings
from the Main menu.

InEight Inc.  |  Release 25.9 Page 53 of 257

Change User Guide 2.20 Change Project Settings



The image below shows you the two ways you can access Project settings from the Project home page.
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Some settings defined at the organization level will limit the settings you can define at the
project level.

The following steps walk you through how to navigate to project settings.

Open Project Settings

1. From the home page, click theMain menu icon on the upper-left side of the page.

2. Click the All projects & organizationsmenu option.

3. On the Projects tab of the All projects and organizations page, search for the Steel Training job.
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4. After you find the project, click the project link in the Name column. The Project home page
opens.

5. Click Settings from the Main menu. The Project settings page opens.
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6. Click the Change icon in the left side navigation. You can use the expansion arrows to see the
icons with product names.
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2.20.1 IDF Response Codes

The Issue Documentation Form (IDF) section of Change allows you to view the IDF field name that is
mapped to the response code by toggling the switch to on (green check).

2.20.2 Notifications

Under Notifications, select which notifications to turn on. Select the time of the email and use the
drop-down list to assign users or roles.

2.20.2 .1 Wr i t ten Not i f ica t ion Time Requi rement

The first section of the notifications sections allows you to control within how many days the project
must notify the client of issues based on the prime contract. It also allows for the scheduling of email
times and users/roles assignments.
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When written notification is set up, the user receives the following notification email, where the links
direct to the specific issue details or the issue log.

2.20.2 .2 Not i fy Scheduler o f Issues

This is an email notification that is sent to recipients based on schedule impact of an identified issue.
The email notification includes new issues that have a Yes selected for scheduled impact within the
Issue Detail page.
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2.20.2 .3 Not i fy Ass igned To Persons

The user receives a summary notification of issues, PCOs, and CCOs assigned to them, where the links
direct them to the specific issue details.

Example 1: Email with notification that an issue has been created and needs approval.

Example 2: Email with notification that an issue has been approved.
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2.20.2 .4 Not i fy cont ro l le r o f ad jus tments

The Notify controller of adjustments settings let you notify a user when a contract adjustment or
budget move has been sent to InEight Control.

Items are sent to Control when a client change order is executed. The email notification includes all
adjustments that have been sent to Control.

2.20.3 Workflow

One of the primary objectives of Workflow within Change is to provide users or roles with applicable
access to approve issues, PCOs, or CCOs. Approvers will see different tabs on the Change register than
a user with only viewer access.
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2.20.3 .5 New issue approva l setup

Setting up a workflow for new issue approvals lets you specify approval steps and the users or roles
responsible. The steps are performed for all new issue approvals in the project. The workflow cannot
be edited in an individual new issue.

New issue approval workflows are configured on the project Settings > Workflow Assignments > New
Issue approval setup page.

Add a new issue approval workflow

Add a new approval workflow to specify how a new issue gets approved.

1. From the New approval setup page (Settings > Workflow Assignments > New Issue approval
setup), click the Add approval icon. The Add approval slide-out panel opens.

2. Enter a title for the approval step.

3. Select whether the step is to be approved by a specific user or a user in a role, and then enter
the name of the user or role. User names include email addresses to help you distinguish which
user to enter.

4. Click Add. The step is added to the grid.

5. Repeat steps 1-4 for each approval step. You can use the up and down arrows to change the
order of the steps.

6. Click Save.

When there is at least one step in the workflow, any new issues go into the New issue log with a status
of In approval, and an email notification is sent to the approver.
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2.20.4 PCO and CCO approvals

The Workflow Assignments tab of your project settings is where you set up approval processes for
approving PCOs and CCOs. The settings include defining the number of steps in approval processes and
making assignments of who approves each step.

2.20.4 .6 Group work f lows

Change orders often have varying approvers, which can result in changing the project settings for each
change order. Configuring approver group workflows provides alternatives in the approval process,
which saves you from manually altering the workflow at the project level each time you require a
change-specific workflow.

An approver group is a set of users or roles in steps, similar to an entire workflow. You can set up
multiple groups in a single step in a workflow. For example, when a project is done in segments, you
might have a different set of approvers for change orders in each segment. Instead of setting up a
workflow that applies to the whole project, you can create a multistep group workflow for each
segment. You can have one or more group steps in a workflow.

You can configure groups from the Group approver setup page (Project > Settings > Change> Workflow
Assignments > Group approver setup). Each group can act as its own workflow. In the sample image, a
project has two segments, each with a different field engineer and project engineer. The business
manager is the same for both segments. A business manager only group is set up for a flow that only
needs approval from the business manager, such as resubmitting a previously rejected payment form.
All PCOs and CCOs in the project can use the groups.

When you start the approval process from the PCO or CCO, you can select the appropriate view when
you click Save and Start approval.
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Create group workflows

Use group approval workflows as a single step in a larger workflow. The group workflow is users or
roles arranged in steps, like the steps used in thresholds. Group workflows let you set up segment-
specific workflows to use when a change order has multiple segments or when only one user or role
must give an approval.

Only one step in an entire workflow can have a group step.

1. Go to the Group Approver Setup page (Project > Settings > Change > Workflow
Assignments > Group approver setup).

2. Click the Add group approval button. The Add group approver slide-out panel opens.

3. Enter the group approver name (for example, Segment 1), the step title of the first step (for
example, Field engineer), and the users or roles for that step, and then click Add. The
group and its step are added to the grid.

4. To add another step, click Add another step, and then enter the step title and approvers.
Click Add. Repeat this step as necessary to add all steps in a workflow.

You can change the order of the steps by selecting the step and using the up and down arrows. You
can use the group approval as a step when setting up PCO or CCO approval workflow.

2.20.4 .7 Change order approva l setup

You can set up dollar-value thresholds for PCOs or CCOs at the project level. The project has an
approval matrix where any dollar amount over the threshold set must be approved.

In the project settings, go to Workflow assignments > PCO approval setup or CCO approval setup.

Add a workflow assignment

Add a workflow assignment threshold to set the amount at which a PCO or CCO must be approved.
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The workflow steps set at the project level are performed after those set at the PCO/CCO. However, if
the value of the PCO or CCO is below the project level thresholds, the workflow thresholds set at the
project level will not show in the Workflow Assignments.

1. Go to the Workflow Assignments tab.

2. Select the PCO approval setup or CCO approval setup tab. If an organization step shows a red
hazard icon, you must edit the step to select specific users based on assigned roles.

3. Click the Add approval icon.

4. In the Add approval slide-out panel, enter the threshold amount and approval step title.

5. Enter the roles, users, or groups in the Assign approval roles field. You can also assign an
approver as required by the organization level when you edit a threshold at the project level.
When you edit a project-level threshold, the Edit approval slide-out panel includes a view of the
organization-level steps at the same threshold. If the organization-level steps require editing,
you can assign a user. All other fields of the organization steps are read-only. If the organization-
level steps do not require editing, the entire step is read-only.

InEight Inc.  |  Release 25.9 Page 65 of 257

Change User Guide 2.20 Change Project Settings



Organization steps that require editing are marked with a red triangle in the approval details. If
there are no project-level steps, you can edit the organization-level steps individually.

6. Click Add to complete.

7. If you want the approval workflow for the threshold to have additional steps, click Add another
step. To change the position of a step, select it, and then use the up and down arrows to the
right of the steps to move up or down.

Users, roles, or groups can be assigned to steps at a project threshold.

Project-level thresholds cascade to every PCO or CCO. In a PCO or CCO, you can add additional
approval steps. These steps are first, regardless of the value of the change order.

Document approva l setup

The Document approval setup lists document types for each document type instead of thresholds. For
document approval, you select a document type, and then add approval steps.
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2.20.5 Overview – CCO execution setup

Item Field Definition

1 Allow users to
approve/reject
executed
CCOs

This setting is automatically defaulted to No. If it is set to Yes, users
are allowed to approve/reject issues.
If the option is set to On, you cannot switch to Off, if there is anything
active in Workflow. If you would like to turn off Workflow, you would
need to approve/reject/cancel all the pending Workflows, and then
turn it Off. You can set up the Workflow to receive one email for each
CCO, or receive a summary email of pending CCOs. If you select the
second option, then you can select a specific time that the summary
will be emailed.

2 Receive on
email for each
CCO

User or Role will receive an email for each individual issue.

3 Receive a
summary email
of executed
CCOs

User or Role will receive a summary/grouping formatted email,
instead of receiving individual issue emails.

4 Assign user or
roles for CCO
approval

When choosing the users option, you can select from a list of users
to send out emails. If you choose the roles option, you can choose
for a list of pre-defined roles.

Overview – CCO execution setup
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Item Field Definition

5 Users/Roles Based on what is chosen for “Assign users or roles for new issue
approval”, you will need to choose from a list of users or roles. User
names include email addresses to ensure that you select the correct
user account.

Overview – CCO execution setup (continued)

2 . 21 CONF IGURAT IONS

Project-level configurations let you customize Change for your project. To see the configuration
settings, go to project settings, and then select Change >Configurations.

2 . 22 ID CUSTOMIZAT ION

2.22.1 ID customization

Configuration settings for ID customization (Project settings > Change > Configurations > ID
Customization) lets you override the organization-level numbering when projects are allowed to edit
PCO or CCO IDs (that is, the Allow projects to edit settings check box at the organization level is
checked). Override the organization-level numbering by setting the Generate Potential Change order
IDs sequentially toggle to Yes. If set to No, IDs function as free text.
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When the Generate Potential Change order IDs sequentially toggle is set to Yes, the Allow users to edit
generated IDs toggle is shown, and the Prefix and Starting number fields are enabled. You can set the
Allow users to edit Generated IDs to Yes to allow users to edit the generated IDs when creating a PCO
or CCO or for a PCO or CCO that has been generated. When the field is set to No, users cannot edit the
IDs and must use the IDs generated by Change.

You can edit the starting number field only if a PCO or CCO has not been created.

2 . 23 PR IC ING MARKUP

The Pricing markups Configurations (Project settings > Change > Configurations > Pricing markup) is
used to bring over markup values into the Pricing summary and cost item pricing.

You can configure a predefined set of markups and either have the markups automatically populate in
the Pricing summary tab or Cost item pricing tab for an issue, or otherwise choose to select specific
markups from a list set.

Item
Number Field Definition

1 Markup
Name

Actual name of markup.

2 Markup
percentage

Amount added to the cost price of goods or services to cover
overhead and profit. Percentages can have up to three digits
before the decimal.

3 Applied to
section

The section that the markup applies to, which includes Labor,
Equipment, Materials, Small tools & supplies, Self-perform
subtotal, Vendor Subtotal, Time related overhead, and Grand total.
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Item
Number Field Definition

4 Markup level Markup calculation levels can be added to the Grand total in cost
item pricing or to the Grand subtotal in the pricing summary. Levels
0-4 are available. Markups to other sections are automatically
added at level 0. See Markup calculation levels for more
information.

5 Auto Display If set to Yes, the markup populates automatically under the Pricing
summary column. If set to No, you have the option to bring in the
markup, but the markup does not show automatically.

2 . 24 ALLOWANCE CATEGORY

Projects need a way to track issues or change orders against project specific allowances defined within
Prime (client contracts). Allowance categories and values are customizable within each project settings
by manual entry. This customization has specific permissions around edits. Issues can select a category
if it applies for tracking purposes. This provides a project's ability to customize based on Prime Contract
and provide assistance in forecasting. If the WBS has costs appear in the OB or CB total cost associated
within InEight Control, it automatically populates. The values are for reference or comparison purposes
only.
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Setting the categories is done under the Project settings > Change > Configurations > Allowance
Category tab. The settings default to Warranty, Allowance and Contingency. These categories are
editable.

Additional categories can be added by typing in the name of the allowance and value, then select Add.

The categories show in the drop-down list under Change > Issue Log > Details > Allowance category to
be tagged against. These categories are meant to track values which dollars need to be tracked against.
If a WBS was associated from the Allowance category, its number appears in the WBS window.
Selecting the eye icon opens an additional information window about that WBS.
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2 . 25 DEPENDENT COST ITEMS

The Dependent cost items Configurations section (Project settings > Change > Configurations >
Dependent cost items) is used to bring dependent cost item values into cost item pricing.

You can configure a predefined set of dependent cost items so you can select specific markups from a
list set.

Field Description

Dependent
cost item
name

The name of the dependent cost item that will show in cost item pricing.

Cost
percentage

The percentage to be multiplied by all items in the cost item pricing section to
calculate the value of the dependent cost item.

WBS The WBS code for the dependent cost item.

Applied to
section

The section that the dependent cost item applies to, which includes Labor,
Equipment, Materials, Small tools & supplies, Self-perform subtotal, Vendor
Subtotal, Time related overhead, and Grand total.

2.25.1 Allow users to edit adjusted cost

When the Allow users to edit adjusted cost setting is enabled, users can edit the adjusted cost or cost
percentage of a dependent cost item in an issue. When you edit the Adjusted cost field, the Cost
percentage field is automatically recalculated and vice versa. When editing the adjusted cost is
disabled, the dependent cost item values cannot be overwritten by a user.

Page 72 of 257 InEight Inc.  |  Release 25.9

2.25 Dependent cost items Change User Guide



2 . 26 DEC IMAL PREC IS ION

You can use the Decimal precision configuration to set the number of digits that follow a decimal point.
The precision decimals are used in issue, potential change order, and client change order logs, detail
pages; and pricing. Exports for the logs also support decimal precision.

Tag output uses two decimal places.

You can set decimal precision on the Decimal precision configuration page (Project settings > Change >
Configurations > Decimal precision). You can choose separate decimal precision for values, quantities,
and percentages.

You can choose 0-11 digits. If you choose 11 digits, the decimal characters do not fit in the fields of the
issue, PCO and CCO headers, and an ellipsis is shown. If you do not enter a value, Change uses a default
value of 2.

2 . 27 MESSAGE CONF IGURAT ION

Your organization has set defaults for scope status in the organization level settings. This helps drive
business behavior or requiring messages for status charges. At the Project level settings, access from
Project settings > Change > Configuration >Message configurations. From the Configuration list you
can toggle on/off the display message, as well as allowing notes. The explanation icon depicts this line
item is set at the organization level.
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2 . 28 RESPONS IBLE PARTY

Your organization can establish a default responsible party list in the organization settings.  The project
inherits the organization list and may mark some as inactive or create additional responsible party
options.

To customize responsible party at a project level, go to Project settings > Change > Configurations.

The organization list defaults to active.  To deactivate, change the toggle in the Action column from
the check mark to the minus sign, and then save.  Only those responsible party options with an active
control are available to select in the issue, PCO, and CCO logs Responsible Party drop-down menus.

2 . 29 CONSTRUCT ION AREA

In Change, for projects that started prior to Release 22.10, there is a drop-down list to reference
Construction Areas to project changes you are tracking. In the Construction Area of Configurations ( 
Project settings > Change > Configurations > Construction area), you can indicate where the drop-
down list of Construction Area comes from.
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On the Construction area section of this page, you can switch the toggle to select the source of the
Construction Area attributes.

When the toggle is set to Yes, construction work area information configured in the InEight Platform
Construction Work area (project > Project values > Area) populates the Construction area drop-down
list in the Field information section of the Additional details in an issue.

When the toggle is set to No, you can enter construction area values, and those values populate the
Construction area drop-down list. The Construction Area attributes are used in Change.

Construction area configuration in Change is not an option for projects that started with release 22.10
or later, the only way to customize Construction area information is in the Platform Construction area
configuration.

2 . 30 CUSTOM L ISTS

Custom lists let you create fields with drop-down lists. Values configured for the custom lists
automatically populate project drop-down lists in the specified order. To configure a custom list go to
Project settings > Configurations > Custom Lists, and then select the custom list.
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You can create two custom lists each for issues, PCOs, and CCOs. For each list item, you can add the list
position and the description. When a list item is no longer needed for your project, you can switch the
Active toggle to Off.

The custom lists are available in the Column options on the issue, PCO, and CCO logs, and you can
change the values directly from the log. The fields are not available on the Details pages.

You can use custom labels (Project > Settings > Change > Custom Labels) to customize the names of
the fields and lists.

2 . 31 ES IGN SETUP

The eSign setup tab (Project settings > Change > Configurations > eSign Setup) lets you add the names
of up to 10 recipients, along with their companies, titles, and email addresses, that can be used with
every contract in the project.

Each eSign recipient field in this list has a corresponding template tag. You can add the tag to
templates to require the signee's signature. The tags are read when sending the document for
signature. You can also add recipients to a document when you send the document for eSignature. See
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5.8 Change writer on page 236 for information about sending documents for signature. See 2.1
Organization settings on page 20 for information about using tags in templates.

If you edit the eSign setup, the recipients are available for new change documents only. You can
override the eSign recipients in the eSign section of the PCO or CCO details.

2 . 32 CHANGE TEMPLATES

Change writer templates added at an organization level are available for projects by default. At the
project level, you may deactivate a template if the template does not suit the needs of the project. 

To deactivate a template, go to the project settings, then select Change > Change Templates >
Organization level templates. Use the Project level use column to change the minus to
the check mark.

Only templates that have the Project level use switch set to On appear in the Project level template list
and be available for selection when generating a Change document from a template.

Templates may also be added directly at a project level. You can also set up the recipients for
eSignature via DocuSign.
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2 . 33 DOCUS IGN SETUP

If your project is integrated with DocuSign for eSignatures, you can embed common signees into your
project templates. See eSign setup for information about setting up eSign.

2.33.1 DocuSign Advanced Options

Change supports the use of DocuSigns Advanced Options. The DocuSign Advanced Options are
configured in DocuSign. These options let you customize the DocuSign experience. Your DocuSign
administrator can set up the following options in DocuSign:

l Branding options let you select a logo and brand colors that were set up by the DocuSign
administrator, for the envelope.

l Reminders options let you specify whether DocuSign sends reminders to signees, when to start
sending them, and how often to send them.

l Expiration options let you set the number of days until the envelope expires and how often to
send alerts. After the envelope is expired, recipients can no longer view or sign the documents in
the envelope.

l Comments options let senders and recipients to enter comments on documents in the envelope.

l Recipient privilege lets you give recipients options for how they sign the document, such as
signing on paper, assigning delegates, and editing documents.

2 . 34 CHANGE CUSTOM LABELS

To view the default values of custom labels set at the organization level, select the Change Custom
Labels tab. You can use the read-only view as a reference, so you can see where tag information is
mapped in a change order. The Enable custom labels toggle lets you specify whether to use the
organization custom labels at the project level. When the toggle is set to On, the custom labels in the
view are used in tabs, fields, tags, and widgets throughout Change. When the toggle is set to Off,
Change uses the default labels.
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2 . 35 PERMISS IONS

Permissions for each role are configured in Suite administration. Refer to the InEight Platform help
topics for more information about roles and permissions.

2.35.1 Supporting documents permissions

If you want a role to be able to add, edit, or delete supporting documents, you must select the Add
supporting documents, Edit supporting documents, and Delete supporting documents permissions
nested under the Edit Change permissions. The check boxes for Add supporting documents and Edit
supporting documents are enabled when the Edit Change permission is selected. The check box for the
Delete supporting documents permission is enabled only when the Edit supporting documents
permission is selected.
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CHAPTER 3 — GENERAL
NAV IGAT ION

The following topics describe how to use the pages and registers in Change.
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3 . 1 PAGE NAV IGAT ION

You can open Change using the link provided by your manager or facilitator. Open a web browser, and
then click the link provided to open the InEight software.

Click theMain menu icon, and then select All projects & organizations.

Click your project Name link to open the project.

If your project is not shown, you can search by selecting the Search icon in the top right corner. This
search function searches all terms in all columns.

After you click the project Name link, the Projects home landing page opens.
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From the Projects home landing page, you can launch Change in multiple ways:
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l Click Change from the left menu

l Click theMain menu icon, and then click the project or organization. Select Change from the list.
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l Select Change from the app launcher icon in the upper-right corner of the page.
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3.1.1 Change Tools and Navigation

Each register page in InEight Change contains menus and tools to help you navigate and perform key
functions on the page.

Title Description

1 Administrative
tools

View your profile and notifications and sign out.

2 Tabs Tabs you can click to access pertinent information.

3 Actions menu Contains actions that can be performed from the register page,
including viewing the import history, launching the reporting dashboard
in InEight Explore, and generating a Change document.

4 Toolbar Contains functions for the register page you are currently viewing, with
specific editing options on the left, such as, add, edit, delete, and copy,
and options that involve the entire page on the right, such as, search,
import and export options, and contract information on the right.

Overview – Change Register Page Tools and Navigation

3.1 .1 .1 Change Toolbar

The options on this toolbar are different for approvers and non-approvers. The toolbar allows you to
use functions for the register page displayed, with basic editing functions on the left and other
functions on the right. The toolbar options will change depending on what page you are currently on.
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Icon Function Permissions

1 Add Add a new issue to the register page. Approver/
Non-Approver

2 Reject After selecting an Issue Id, you can reject an Issue
with the option of adding notes.

Approver

3 Approve After selecting an Issue Id, you can approve an Issue
with the option of adding notes.

Approver

4 Clear all
filters

To clear all logs in the Change application and the
change templates in the project settings.

Approver/
Non-Approver

5 View prime
contract
summary

The sigma icon displays is accessible throughout the
application with details for Prime Contract such as
current and projected contract value, contingency
amounts and milestone dates.

Approver/
Non-Approver

6 Search Search all columns for content by the keyword you
enter.

Approver/
Non-Approver

Overview – Change Toolbar 

3.1.2 Change Register tabs

The Change Register tabs will be visible based upon user access.

Tab Access Definition

n/a New Issue
(when
Workflow is
turned off)

Viewer/Approver An incident that happens during a project that could
incur costs or impact the schedule. New Issue tab
appears when Workflow is turned off.

1 Pending Viewer/Approver Similar to the New Issues tab, except Pending
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Tab Access Definition

Issue Issues shows as a tab when workflow is turned on.
All project users see the Pending Issue tab.

2 Issue Log Viewer/Approver Contains a register of all your issues, even if they are
new issues or have become PCOs and CCOs during
the process.

3 PCO Log Viewer/Approver
A potential change to the owner’s contract that you
are pricing and getting ready to negotiate with the
owner.

4 CCO Log Viewer/Approver A finalized change you are ready to send to the
owner.

5 Action
Items

Approver If you are a designated workflow approver, you see
this Change page that shows an additional tab
called Action Items. The Approve and Reject
buttons are enabled for approvers per the Change
project settings under Workflow.

6 Audit Log Viewer/Approver Captures all changes made into issues, Potential
Change Orders, and Client Change Orders.

3 . 2 COLUMN AND ROW MANAGEMENT

3.2.1 Expand Columns

You can expand a column as needed to see the entire title of that column by using the same method
that you would in Microsoft Excel. When you hover over the column, the cursor changes from the
arrow to the width selector.
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3.2.2 Move Columns

You can move a column from one place to another using drag and drop. If there are columns that you
do not use, you can hide and unhide them from the view as needed.

Move Columns

Summary: You can manually move columns on a Change page to fit your business needs. If you have
multiple columns to move, you can also use the enhanced column management tools. For more
information, see Enhanced column management.

1. On a Change page, click on a column header, hold down the left mouse button, and then drag
the column to the right or left. It shows raised with a shadow box. The right border of the
column shows in dark blue and the icon in the shadow box changes to a plus sign to guide you to
a new column location.
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2. Drop the column header where you want to place the column.

3.2.3 Sort Columns

You can sort any column by clicking once on the column header.

Sort Columns

Summary: Sort columns to change the order of the information on the page.

1. To sort a column, click on the column header. An up arrow symbol shows on the column header
indicating the column is sorted in ascending order

2. To show the column in descending order, click the column header again. The down arrow symbol
shows on the column header.

3. Click the column header again to remove the sort.The arrow symbol no longer shows.
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Filter Columns

Summary: Filter columns to help you quickly find the information you need.

1. From aChange page, click the Filter icon in a column header.

A list of filter operators shows.

2. Select an operator, and then enter filter criteria in the search box in the column header. For
example, using the image in the previous step, you could select the operator Contains for the
Issue name column, and then enter the criteria structure. Change filters the column entries
based on the filter criteria.
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3. To clear a filter, click the Clear icon. If you have used multiple filters, you can click Clear all filters
in the right toolbar.

3.2.4 Manage Row density

You can adjust the row density on the Issue log, PCO log, and CCO log. Click the Row density icon in the
toolbar to select from Relaxed, Narrow, or Tight density.

Row density settings on a grid, such as the Pricing summary, are applied to any slide-out panels or
dialog boxes accessed from that page.

3 . 3 ENHANCED COLUMN MANAGEMENT

The enhanced column management tools in the Issue, PCO, and CCO logs provide an efficient way to
choose and arrange columns in the grids. The column management feature lets you add or remove
columns in the locked sections and remove columns if they are not needed.

To manage columns on a log, click theManage columns icon in the toolbar to open the Column
selector builder.
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Use these sections and tools to help you organize columns in the Issue, PCO, and CCO log grids:

Item Description

1 The Available columns section shows all the columns to choose from that are not
currently used in the grid.

2 The Selected columns section shows all columns that currently show in the grid and
their order.

3 The Search feature lets you search the available columns or the selected columns for a
field.

4 The Move up and Move down icons are enabled when one or more columns are
selected in the Selected columns section. Click an icon to move the selected column
up or down in the list

5 The Transfer to and Transfer from icons are enabled when one or more items are
selected in the Available columns or Selected columns section, respectively. Click the
Transfer to icon to move the selected columns from the Available columns section to
the Selected columns section. Click the Transfer from icon to move the selected
columns from the Selected columns section to the Available columns section.

6 The Transfer all to and Transfer all from icons let you transfer all columns to the
Selected columns section to the Available columns section, respectively.

7 All columns listed above the Locked section indicator are locked and remain stationary
as you scroll left or right. Columns listed below the locked center are unlocked and
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Item Description

scroll left or right. You can use the Move up arrows, or you can drag and drop to move
columns from the unlocked section to the locked section.

Click Save to apply the changes. The changes are saved for as long as you are on the log. To save the
column arrangement as a view, expand the View drop-down menu, and then select Save view as.
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CHAPTER 4 — ISSUES

Change features let you create, manage, and price issues.
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4 . 1 INE IGHT CHANGE WORKFLOW

4 .2 ISSUE CREAT ION AND SETUP

4.2.1 Issue Creation

The following steps walk you through creating a new issue in InEight Change. The Add new Issue wizard
lets you add supporting documents and vendors in a single operation. Vendors added with the issue
show in the Vendors grid on the issue's Details page.

If supporting documents or vendor information, you can edit the new issue later.

Create a new issue

When an issue occurs in your project, you can create a new issue record from the New Issue page or
the Issue log.

Considerations: These instructions assume that you have supporting documents and vendor
information. If you do not have this information, you can click Add or Add and New to quickly add the
issue. If workflow is configured at the issue level, you can click Submit for approval. You can return to
the issue later.
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1. From the New issue page or the issue log, click the Add issue icon. The Add new issue wizard
opens.

2. Enter the issue name and issue start date. You can also optionally enter the ROM, a description
of the issue, and other detailed information.

3. Click Next to go to the Add supporting documents page and then add supporting documents
information. For more information about adding supporting documents, see Supporting
documents. If you do not have supporting documents, go to the next step.

4. Click Next to go to the Add Vendors page and then select vendors from the list.

5. Add or submit as follows:

l If workflow is not configured, click Add to add this issue or Add and next to add an
additional issue.

l If workflow is configured, click Submit for approval to submit for approval or Add and
next to add an additional issue.

If approval is not configured or if you are the first approver in the workflow, the issue is added to the
New issue page and the Issue log with an issue ID assigned and an issue status of New. If a workflow is
configured and you are not the first approver, the issue is added to the New issue log with a status of
Pending. If you added vendors, they are added to the Vendors grid on the issue's Details page.

How the Issue ID, Issue status, and Issue approval status of a new issue are assigned depends on
whether workflow is configured.

l When workflow is not configured, the issue is added to the New issue page and the Issue log
with an issue ID assigned. The issue status is New, and the issue approval status is Not
applicable.

l When workflow is configured and the person who created the issues is also the first approver in
the workflow, the issue is automatically approved for the first step. The issue is added to the
New issue page and the issue log with an issue ID assigned and an issue status of New. The issue
approval status is Approved. When you hover over the issue approval status, it shows that it has
been approved for the first step and is in step 2, if there is a step 2.

l When workflow is configured and the person who created the issue is not the first approver in
the workflow, the first approver (either a person or a role) receives an email letting them know
there is an issue to be approved. The issue is added to the New Issue page with an issue ID of
Pending, an issue status of New, and an issue approval status of In approval. The issue is not
added to the issue log until it has gone through all the approval steps.
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l When issues have been rejected in workflow, they show in the New Issue log with the Issue ID
Rejected, so they can be quickly identified. Rejected issues are disabled, so you can no longer see
the issues. InEight recommends using the Comments section in the workflow to describe the
issue and the reason it was rejected.

When the issue is in workflow, Change allows you to add supporting documents and edit fields that
might help the reviewers in making approval decisions. To open the pending issue, click the Pending
link in the Issue ID column of the New issue log. The Issue Details page opens, and you can then edit
any field that is enabled. You can also go to the Supporting documents tab to add documents.

You can also import issues from a template. See 4.13 Issue Import on page 144 for information about
importing issues.

Contract users can also add an issue from a VCO in Contract. If a new issue approval workflow is
configured, the issue automatically goes to the New Issue log with an Issue ID of Pending. It does not
get an issue ID until it is approved.

4.2.2 Issue Header

When you click on an issue’s ID or name, the issue’s record page opens. At the top of the page, a
header section provides workflow and status information that you can update during the issue’s
lifecycle.

4.2.2 .1 Cost , markup, and markup percent pr ic ing breakdown

The Issue, PCO, and CCO shows the breakdowns of cost, billing markup, markup, markup percent, and
deduction fields. This gives you the visibility into the profit you are making on an issue or change.

The Cost is the total of all priced items. The Billing markup is the markup based on the resource billing
rates. The Markup is the total of all markups from the cost item, Pricing tab, PCO, and CCO. The
Markup %is the markup divided by the cost. Deductions come from the cost item pricing tab and are
subtracted from the current value. Current value is costs plus markups minus deductions.

4.2.2 .2 Status in format ion

The status information lets you see issue status information at a glance. The statuses include the
following:
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l Issue status (called PCO status or CCO status on their respective tabs)

l Pricing status

l Proposal status

4.2.2 .3 Issue sta tus

The Issue Status drop-down menu is used to define the general progress of an issue, potential change
order, or client change order and is the primary indicator used to determine what action is needed
next and by whom. It is used to track the change through the different stages in the change
management process, highlighting its progress from issue creation and review through CCO execution.
Depending on the selection, fields in the selected issue, PCO, or CCO become locked.

The following are examples of statuses you can assign. Your organization or project might have
configured custom statuses:

l In Review – The issue is currently being reviewed.

l PCO – The issue is now connected to a Potential Change Order.

l CCO – The issue now converted to a Client Change Order.

l Parked – The issue is no longer active but may be brought up again later. When selected, all
fields within the issue become locked.

l Dropped – The issue is no longer being considered. When selected, all fields within the issue
become locked.

l Dispute – The issue is under dispute.

l Closed - The issue is closed. You cannot split a closed issue or associate it to a Potential Change
Order (PCO) or Client Change Order (CCO).

Changes made to Issue status open a dialog box where you can add notes related to the assignment
you are making. Notes are not mandatory to save the change but canceling the dialog box causes the
Issue status to revert to the previous state.
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4.2.2 .4 Pr ic ing sta tus

The Pricing status is used to track the progress of all financial activities related to a change, from initial
ROM or cost estimation to the final pricing agreement with the client. This field defines the current
state of the financial evaluation for the Issue, PCO, or CCO. It can be used to track the entire pricing life
cycle, including cost gathering from vendors, internal estimation, review, and formal submission to the
client.

You can select the Pricing status drop-down menu to classify where you are in the process of pricing
the issue. Options include the following:

l Complete

l Not Started

l In Process

l Audit Review

l Complete

When changing the Pricing status, you are prompted to record notes just like you were when changing
the other statuses.
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4.2.2 .5 Proposal s ta tus

The Proposal status is used to track the life cycle of the official proposal package, from initial
negotiations to submission and approval to the subcontractor or client. This field defines the current
state of the formal written proposal that bundles all budgetary, scheduling, and technical details for a
change. It is used to track the progress of the official client-facing document, distinguishing it from
internal pricing and general status.

Select the Proposal status drop-down menu to classify the proposal status of the issue. Options
include:

l Not started

l In negotiation

l Submitted by sub

l Accepted by Contractor

l Submitted to client

l Accepted by client

l Rejected

When changing the Proposal status, you are prompted to record notes just like you were when
changing the other statuses.

4.2.3 Delete an issue

You can delete issues from the Issue log that were entered in error or are no longer valid. The issues
must meet certain criteria based on their status, PCO or CCO association, and origin.

You can delete an issue if it meets the following criteria:
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l The issue must have been created in Change or added via an API. Issues that originate from
another InEight product, such as Plan, Progress, Compliance, Contract, or Document cannot be
deleted.

l The issue must have a status of New, Parked, Dropped, or a custom status.

l The issue cannot be associated with a PCO, CCO, or budget move.

l The issue cannot be a main issue.

If you delete the issue with the highest number, the next issue created will take that number. If you
delete an issue with a number in the middle of the list, that number is not used again.

To delete issues, select one or more issues from the Issue log, and then click the Delete icon. You must
have the permission Delete issues.

4 . 3 DETA ILS TAB

Below the header on the issue record, there are three tabs for capturing the issue’s details, costs, and
supporting documentation.

The Details tab is where you can record key information for understanding the nature of the issue and
its potential impact. It is organized into the following sections:

l Issue details

l Issue description

l Additional details

4.3.0 .1 Issue deta i ls

The issue details section includes fields that identify the issue.

Title Description

1 Issue
navigation

Lets you navigate to other issues without having to go back to the Issue
log. Click the arrow to see a list of issues, and then select one. The
selected issue opens in the same window.

2 Issue name l Free-text entry (will auto populate from initial entry screen)
l Contract will generate un-editable Issue ID separate from Issue
name for internal tracking

l Required to create new issue
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Title Description

3 Issue start
date

l Calendar drop-down
l Select start date of actual impact (will auto populate from initial
entry screen)

l Required to create new issue

4 Description
of change

Free-text entry and editor for description of issue (auto populates from
initial entry form).

4.3.0 .2 Issue descr ip t ion

The Issue description section contains fields that help classify the issue.

Title Description

1 Source/Cause Drop-down menu populated with general issue causes. The
Source/Cause field identifies the underlying reason or root driver, such
as an originating document, event, or instruction that initiated the issue.
The source or cause typically requires investigation to determine why
the issue occurred (for example, the initial soil analysis was incomplete
or inaccurate).

2 Change
condition

Drop-down menu populated with general conditions of change. The
Change condition identifies the immediate event or circumstance that
triggered the issue (for example, encountering rock in an area where
soil was expected.)
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Title Description

3 Scope Drop-down menu populated with scope identification of issue.

4 Allowance
category

Category assigned to issue for tracking.

5 Vendors An area where you can associate vendors to an issue without having to
go to the Pricing page.

6 Assigned WBS Validated WBS structure to associate a code with your issue. WBS
codes include all terminal cost items from InEight Control. WBS codes
can be assigned from InEight Plan or Control, or from this section.
If the project is imported again from InEight Estimate after the WBS is
associated, you must manually update the issue with the newWBS
code.

7 Push to cost
item pricing

Automatically add the WBS codes to the cost item pricing for the issue.

Associate a vendor to an issue

Associate one or more vendors to an issue when you have vendor information, but you are not ready
to price the issue.
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Vendors must already have contracts on the project to be able to be selected from the issue Details
page.

1. From the issue's Details page, click the Add vendor icon in the Vendors field. The Select vendor
dialog box opens.

2. Select one or more vendors from the Available Vendors list, and then click Add. The vendors are
added to the issue.
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3. On the Details page, click Save.

When you are ready to price the issue, you can add a vendor to cost item pricing.

Add a vendor to cost item pricing

Add a vendor to cost item pricing from the Details page when you have already added vendors to the
issue and are adding cost items.

1. From the issue's Details page, select a vendor, and then click Push to cost item pricing in the
Vendors field. Only vendors that have been added from the Details page can be pushed to cost
item pricing. Vendors that have already been added to cost item pricing are shown as disabled.
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The Select WBS to push to cost item pricing dialog box shows with a list of all contracts
associated with the vendor and associated WBS phase codes.

2. Select one or more WBS phase codes, and then click Add. The vendor is added to the Vendor
section of cost item pricing and shows on the pricing summary. It also shows as disabled in the
Vendor list of the issue's Details page.

After you push the vendor to cost item pricing, you can associate the cost item to a vendor change
order.

If you have pushed a vendor to cost item pricing by mistake and want to remove it, you must remove
the cost item pricing item from the Pricing page and then remove the vendor from the Pricing
summary. The vendor is then automatically removed from the Details page. When a vendor is
associated to a vendor change order, you cannot delete the vendor from the Vendors section.

Push a WBS code to cost item pricing

You can push the WBS codes you add to an issue directly to the cost item pricing for the issue, so you
do not have to add them again when you configure cost item pricing.

This procedure adds the WBS codes to the cost item pricing. Any items that you add to the pricing are
not pushed to the Details page. You can add them manually.

1. On the Issue Details page, enter the WBS codes you want to use for the issue in the Assigned
WBS field.

InEight Inc.  |  Release 25.9 Page 107 of 257

Change User Guide 4.3 Details tab



2. Click Push to cost item pricing. The Push WBS to cost item pricing dialog box opens.

3. Select the WBS codes you want to push to the cost item, and then click Add. The items are
added to the pricing.

Items that are manually added on the Cost item pricing tab are not automatically added to the details.
You must add them manually.

4.3.0 .3 Addi t iona l deta i ls

The Additional details section has expandable subsections for the following features:

l Control budget change

l Schedule impact

l Responsible parties

l Correspondence

l Request for information

l Tasks

l Weather

l Field information

l Design information

l Revenue category

l Project values

l Custom fields

Click the arrow in the subsection heading to expand the subsection.
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Title Description

Control
budget
status

The status of the budget move in InEight Control. You can click the link in the field
to go to the Control Workspaces page.
When this field contains a value, the heading for this section shows the
corresponding status icon from Control. See Budget moves for more information
about initiating a budget move.

Control
change
register ID

The change register ID from Control. You can click the link in the field to go to the
Control Workspaces page.

Overview - Details Tab - Control budget change

Title Description

1 Has work started? Yes/No drop-down menu.

2 Delay days The number of delay days associated with the issue.

3 Does this impact the
schedule?

Yes/No/TBD drop-down menu.

4 Schedule impact
comments

l Free text entry to enter comments explaining how the
issue will impact the schedule

l Only available if you select Yes for Does this impact the
schedule?

Overview – Details Tab – Schedule Impact
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Title Description

1 Assigned to Validated drop-down list of users assigned to current project.

2 Responsible party The job title or role responsible for the issue.

3 Responsible party
person

The person who is responsible for the issue. This is a free text
field.

Overview – Details Tab – Responsible Parties
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Title Description

1 Have you
verbally notified
the client?

Yes/No drop-down menu.

2 Conversation
summary

l Free text entry of summary of client verbal notification
l Only available if you select Yes for Have you verbally notified the
client?

3 Date client
notified

The date the client was notified. An information icon in the Date column
shows the specific supporting document that must be attached to
populate the date. You can add the document on the Supporting
documents page. After a document is added, a link is shown in the
File/Link column.

4 Date price to
client

The date the price was communicated to the client. An information icon
in the Date column shows the specific supporting document that must
be attached to populate the date. You can add the document on the
Supporting documents page. After a document is added, a link is
shown in the File/Link column.

Overview – Details Tab – Correspondence
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4.3.0 .4 Request for In format ion

RFIs are often a result of an issue. You can manually add RFI documents from this section or from the
Supporting Documents page. If you manually upload an RFI, only the Title and RFI No. columns are
filled. The Status column is only filled when you add an RFI from InEight Document. The heading for the
Request for Information section includes a counter so you can quickly see the number of associated
RFIs the issue has.

To add an RFI document from this section, click the Add Request for information icon, and then select
whether to add a new document or a document from InEight Document.

Although you can add an RFI to a PCO or CCO, the Request for information section only shows
for issues.

Title Description

1 Task
count

The number of pending and overdue tasks for the issue.

Overview – Details Tab – Tasks
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Title Description

2 Task
title

The name of the task. The name is a link to the task in InEight Compliance.

3 Task
person

The name of the person assigned to the task.

4 Due
date

The date the task is due. Overdue tasks are highlighted in red.

5 State The state of the task (scheduled, pending, overdue, complete). Pending tasks
are highlighted in yellow; overdue tasks are highlighted in red;

Overview – Details Tab – Tasks (continued)

Title Description

1 Weather
heading

Lets you see at a glance the first weather condition assigned in the issue.

2 Weather
condition

You can select a weather condition from the drop-down list. An icon for the
weather condition is shown in the Weather heading. You can select
multiple weather conditions (for example, snow and wind), but only the first
icon shows in the heading.

3 Create
historical
weather
record

Lets you create a historical weather record for a seven-day period. The
historical weather record uses the longitude and latitude from the project
details to give a precise report of the weather conditions for the specified
period. You can specify a start date that is up to one year before the current

Overview – Details Tab – Weather
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Title Description

date. The end date can be up to seven days after the start date. The
conditions include the temperature, weather condition, wind speed in
meters per second and miles per hour, and precipitation.
Change creates a PDF of the record and stores it in the Supporting
documents tab for the issue.

Overview – Details Tab – Weather (continued)

Create a historical weather record for an issue

You can create a historical weather record for a seven-day period within the last year.

If you choose a start date that is less than seven days from the current date, the report is for the
period from the start date to the current date. You cannot choose a date that is older than a year from
the current date.

1. From the Issue Details page, expand the Weather section in the Additional details.

2. Click Create historical weather record. A weather record dialog box opens.
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3. Enter a start date and time and end date and time, and then click Search. Change calls a weather
API and then returns hourly weather conditions for each hour.

4. Click Create. Change creates a PDF of the weather record and stores it in the Supporting
documents tab for the issue.

Title Description

1 Construction
Area

The construction area associated with the issue. Select from a list of
construction areas defined in InEight Platform from the drop-down menu.
The Settings icon is a shortcut to the Construction areas configuration
(project > Project values > Area), so you can configure a new
construction area, if needed.

2 Field Contact Validated drop-down list of users assigned to current project.

3 Daily Plan ID
of impacted
work

The daily plan ID associated with the issue. You can click the Add daily
plan ID of impacted work button to add additional daily plan IDs. The
daily plan ID is for reference only. You can click the Daily plan ID search
icon to search for plan IDs in InEight Plan or InEight Progress. The Daily
plan ID search lets you select operators, and the search returns plan IDs
that meet the search criteria. Values selected from the search results are
hyperlinked to the fields in Plan or Progress.

Overview – Details Tab – Field Information
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Title Description

4 Latitude and
Longitude

The latitude and longitude of the construction area associated with the
issue. These fields are for reference only.

Overview – Details Tab – Field Information (continued)
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Title Description

1 Plan/detail sheet
number

Click the Add link to display a field to enter plan/detail sheets –
optional entry field.

2 Specification
section number

Click the Add link to display a field to enter specification section
numbers – optional entry field.

3 Components Click the Add link to display a field to enter related components –
optional entry field.

Overview – Details Tab – Design Information

Title Description

1 Revenue
category

The revenue category for the issue. The revenue categories are defined in
the organization master data. You can select the category from a drop-
down list.

Overview – Details Tab – Revenue category
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Title Description

2 Revenue
change
status

The change status of the revenue category. This field is read-only.

3 Probability
percentage

The probability percentage based on the settings in the master data. This
field is read-only.

Overview – Details Tab – Revenue category (continued)

4.3 .0 .5 Pro jec t va lues

The Project Values section shows the project values configured for the project. For each project value,
you can select a value from the drop-down list. Each field has a Settings icon that takes you to the
Available project values page of the project. You can add project values or change the status of existing
project values with the applicable permission.
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4.3.0 .6 Custom f ie lds

Custom fields include Issue custom lists 1 and 2 and Issue custom fields 1-4.

4 . 4 REV IEW OR APPROVE AN ISSUE

If you are an approver in the approval workflow, you are notified by email when you have an issue to
approve. If you are an approver in the first approval step, your issue is automatically approved, and the
approval step is skipped.

Review or approve an issue

Summary: Review or approve an issue when workflow is configured and you get a noticiation

1. Navigate to the Steel Training Job > Change > Issue Log.

l Since you are an approver, your issue is not queued for approval and is in a Review status.

l Notice that an Issue ID has been assigned to the issue.

2. Click on the Issue ID for [your initials] – Bearing Pads.

3. As part of your review as an approver, go into the Issue and make a change to the Description.

l Description: Add This is a high priority
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4. Select Save.

4 . 5 CHANGE TOOLBAR

Change has Project contract summary, supporting documents, and Notes icons available on every tab.

See Supporting documents for information about using the Supporting documents tool.

4.5.0 .1 Pro jec t cont rac t summary

Click the Project contract summary icon to open a slide-out panel that has a breakdown of the totals.

Title Description

1 Current
project value

The sum of the original project value and the Executed CCOs.

2 Projected
project
value

The projected project value is the sum of the current project value and the
Non-executed CCOs. The Potential project value is the sum of the
projected project value and the non-executed PCOs.

3 Milestones Lists of contract and forecast dates for the project. The Forecast start date,
Duration, and Completion date are entered on the Project details page.
The Extension/Reductions, Revised duration, and Revised completion

Page 120 of 257 InEight Inc.  |  Release 25.9

4.5 Change toolbar Change User Guide



Title Description

date are sent to the Project details page. Extension/Reductions are
updated and populated from the CCO schedule impact dates upon
execution of the CCO, and the revised completion date is updated
accordingly. The Estimated float is the difference between the Forecasted
revised completion date and the Contract revised completion date.

4 Allowance
category

The totals of any issues associated with an allowance category on the
Issue details page out of the total value that was assigned to that category
in the project settings.

4.5.1 Add notes

To add notes to an issue, click the Add notes icon. The Notes slide-out panel opens, and you can view
previous notes and add a new one.
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The supporting document notes are maintained as the issue moves up to a PCO and CCO.

When you add notes on the Supporting documents tab, the slide-out window has a tab that lets you
add notes that are specific to the document. Notes added at other levels are also visible.
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When you approve or reject a document at the issue level, the notes you add for the approval or
rejection are also visible at the PCO and CCO levels.

4.5.1 .2 Al lowance Category Summary

When you open the Prime contract summary panel with the sum icon button, an Allowance category
section is at the bottom of the panel. This section shows all of your project’s allowance categories and
their calculated amounts. Color-coded bars show how much of each category’s amount is actual,
potential, or remaining. You can hover over each color in the key to see definitions. These amounts are
defined as:

l Actual- Sum of closed and executed issues
l Potential- Sum of all issues except closed, dropped, and executed
l Remaining- Allowance value minus the sum of actual and potential
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4 . 6 CURRENT VALUE

The Current value of an issue is displayed in the issue log as well as the far left of the issue header.
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The issue’s Current Value updates automatically with the information entered in the Pricing fields. The
value that the Current Value displays comes from the sum of the Self perform and Vendor subtotals,
plus any lump sum adjustments, if any.

4 . 7 SUPPORT ING DOCUMENTS

The Supporting Documents tab houses all the documentation for the issue in one location. This
includes checklists, designs, diagrams, insurance, meeting notes, permits, proposals, etc. By housing
this in one tab, all involved with the issue can verify all necessary documentation is gathered from the
parties involved.

You add supporting documents by clicking the Add icon on the issue’s Supporting Documents tab. You
have the choice of adding a new supporting document or adding a document from InEight Document.

When you choose New supporting document, in the resulting Add supporting documents window, you
can add the appropriate documents as needed by filling out the Title and Document type in the Add
supporting document dialog box, then browsing to your document file and attaching it. When the
document is added from InEight Document, and the document type in Document matches a document
type in the cloud platform, that value shows as the default document type. You can edit the document
type as needed.
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When you add a supporting document type of Proposal and subtype From vendor, you can optionally
select a contract from a list of all vendor contracts on the issue and then select from a list of all vendor
change orders associated with the contract. This lets you specify the contract and vendor change order
that is related to the supporting document and visibility to the contract associated with the proposal.
The document is then visible in InEight Contract as read-only on the main Supporting document
register and the contract's Supporting Document tab. If a VCO association to a contract is made, the
supporting document also shows in the Contract or VCO supporting document page.

The action Contract takes depends on the action taken in Change:

l When you add a pricing item without a VCO ID to the Vendor section of the pricing summary and
then add a supporting document with type Proposal and subtype from vendor, a new field,
Vendor Change order ID is shown in the New supporting document dialog box. If you click Add
without adding the VCO ID, the document is added to the contract's Supporting documents page
and the main Supporting documents page in Contract. See "Pricing" for information about
adding pricing items.
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l When you create a new VCO from the pricing item, a vendor ID is associated to the pricing item.
When you add a new supporting document Proposal from vendor, you can select the VCO ID.
When you add the document, it is added to the VCO's Supporting documents page, the
Contract's supporting documents page, and the main Supporting documents page in Contract.

l When no contract ID is entered, Change sends the proposal to Contract. The document shows in
the Contract main Supporting document register until you add a contract ID in Change.

The document is read-only in Contract because it came from Change. If the documents are updated in
Change, the changes will show in the document in Contract. For example, if you change title, Contract
updates the title. If you change the document type or subtype, Contract deletes the document.

You can upload a saved supporting document to Document from Change, so you do not have to load it
in Document, and then link it back in Change.

Upload a document to Document

Upload a supporting document to Document when you want to take advantage of Document's
organization and versioning features.

Only documents with the document sourceMy computer can be uploaded.

Single-sign on is available for Change to Document features, such as creating mail or a form.
When you use one of these features, the Document sign-on page opens, and you can enter your
credentials. This creates a sign-on token that lets you remain signed in until the session ends.
The first time you sign in to Document, a black secondary window and the Document Home
window also open. You can close these windows. Single sign-on is activated, and they are not
shown again.

1. From the Supporting documents register, select a document with the document sourceMy
computer, and the click the Upload icon.

2. If you are not already signed into InEight Document, use your credentials to sign in to
InEight Document.
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A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Change, a black secondary window and
the Document Home window are shown. After you close these windows, single sign-on (SSO) to
Document is activated, and they are not shown again.

The Upload window in the Documents module of Document opens with the document you
selected in Change already attached.

3. If you want to add more documents, you can add them at this time.

4. Click Save and Transmit. The document is now saved in the Document Documents module.

5. Close the Document window. Change shows the Edit supporting document dialog box. The file
link is replaced with the document link form Document.

6. Click Save. The Supporting documents register refreshes with the file link to the Documents
module. The Document source is replaced with InEight Document, and the External document
type and status are now populated.
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4.7.1 Show supporting documents in generated documents

A toggle on the Supporting documents register, Show in generated document, lets you indicate
whether the document is shown in a collection table based on the collection table type. When you
have a supporting document that you do not want to show in a collection table in a generated
document, set the toggle to No. When a document is generated, only the documents that were set to
Yes are shown.

A document that is available at more than one level, such as an issue-level document available on the
issue, PCO, and CCO Supporting documents pages, can have a different setting at different levels. For
example, you might set the toggle at the issue level to Yes to show in a generated document. You could
set the toggle at the PCO level for the same document to No to not show in a PCO document. Change
uses the setting that corresponds to the level of the collection table tags in the template. Using the
previous example, Change shows the supporting document in a collection table as follows:

l When you generate a document for an issue, the document is shown because the only collection
table type in an issue document is an issue table.

l When you generate a document for a PCO that has an issue-level collection table, the document
is shown because it is part of an issue-level collection table.

l When you generate a document for a PCO that has a PCO-level collection table, the document is
not shown, because the document is suppressed at the PCO collection table level.

4 . 8 V IEW A SUPPORT ING DOCUMENT

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.
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To download the document to your workstation, click Download file.

4 . 9 CREATE AN RF I FORM IN INE IGHT
DOCUMENT

You can create an RFI form in the InEight Document Mail module from an issue. Document saves the
form and creates a link in the Change Supporting documents tab.

Create an RFI Form in InEight Document.

Single-sign on is available for Change to Document features, such as creating mail or a form.
When you use one of these features, the Document sign-on page opens, and you can enter your
credentials. This creates a sign-on token that lets you remain signed in until the session ends.
The first time you sign in to Document, a black secondary window and the Document Home
window also open. You can close these windows. Single sign-on is activated, and they are not
shown again.
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1. In the Supporting Documents tab of an issue, expand the Actions drop-down menu, and then
select Create document > Form.

2. Select Request for Information in the pop-up window.

l The Create new form window will open showing available forms
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3. If you are not already signed in to InEight Document, use your login credentials to sign in.

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Change, a black secondary window and
the Document home window are shown. After you close these windows, single sign-on (SSO) to
Document is activated, and they are not shown again.
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4. After the New Request for information window opens, complete the form.

5. When completed, select the users for distribution of your form.

l A Notification of success appears.

l This allows you to go into Document from Change and grab a pre-defined form, fill out the
information, save, and complete.

l In the Add Supporting documents window, a link to the form you just completed,
appears.
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l Under the Request for information window, this form now appears with a status of
Outstanding.

l You access this file in Document by selecting its title.

If Create document > Form is inactive, you can select the cogwheel icon to set up integration
with InEight Document.

You are then taken to InEight Document’s Forms module to fill out the form. If you save and complete
the workflow, the new RFI populates the Request for information box in the Details tab of the issue.

You can see issues with attached RFIs in the References column of the Issues log register. If there is an
RFI associated with the issue, the column shows the number of associated RFIs. Click on the link in a
cell for more information about the RFIs and links to the files.

4 . 10 CREATE MA IL IN INE IGHT DOCUMENT

You can create mail in the InEight Document Mail module from an issue. Document saves the mail and
creates a link in the Change Supporting documents tab.
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Create mail

Single-sign on is available for Change to Document features, such as creating mail or a form.
When you use one of these features, the Document sign-on page opens, and you can enter your
credentials. This creates a sign-on token that lets you remain signed in until the session ends.
The first time you sign in to Document, a black secondary window and the Document Home
window also open. You can close these windows. Single sign-on is activated, and they are not
shown again.

1. From the Details page go to Actions > Create document >Mail.

2. If you are not already signed into InEight Document, use your login credentials to sign into
InEight Document.

A sign-in token is created that lets you remain signed in to Document until the session ends. If
this is the first time you are signing in to Document from Change, a black secondary window and
the Document Home window are shown. After you close these windows, single sign-on (SSO) to
Document is activated, and they are not shown again.
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3. The Create Document Mail dialog box opens. Select the mail type from the list defined in
Document that are specific to the project's mail type, and then click Next.

4. Optionally add an attachment. If documents were previously selected on the Supporting
documents page, they are already selected in the dialog box.

l To add an attachment from the Supporting documents tab, click Next. The Select
documents dialog box opens. You can choose documents from the Supporting documents
tab with the Document sourceMy computer. After you attach the documents, click Create.
The Mail module opens in Document with your attachments included.

l To add an attachment in Document, click Create. The Mail module opens in Document.
Click Attach files > Attach Documents, where you can search for the document. After you
select a document, click Save.

l To send mail without an attachment, click Create. The Mail module in Document opens.

5. Enter information in the To and Subject fields. The other fields on the page are optional. Enter or
update the fields as needed for the mail message, and then click Send. A summary page opens.

6. Edit links and notes, if needed. The mail is added in Document.

7. Close the Document window. You are then prompted to add the mail as a supporting document
in Change. The document type defaults to Correspondence but can be changed.

8. Click Save to save the mail to the Supporting documents page.
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4 . 11 PACKAGE SUPPORT ING DOCUMENTS

When you have multiple related documents, you can package them into a single document, so you do
not have to download each document separately and combine them outside of Change. You can use
packaged documents to send to InEight Document or send out for electronic signature.

Package supporting documents

You can package documents when you want to combine multiple documents into a single document.

Documents must be in Microsoft Word or Excel, PDF, or image format and come from the document
source My computer to be added to a package.

1. From the Issue, Potential Change Order, or Client Change Order log, select multiple documents,
and then click the Package documents icon.

The Package supporting documents dialog box opens to the Selected documents step.

2. You can select additional eligible documents to be in the package or reorder the documents in
the package.
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3. Click Next to go to the Package document details step.

4. Enter the title, document type, file or link name, and notes. The File/Link name field defaults to
the value you enter in the Title field, but you can change it.

5. Click Save to save the package as a PDF in the Supporting documents register.
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4 . 12 MA IN AND SUBORD INATE ISSUES

Main issue adds flexibility within the tool to be able to group issues together and get a roll-up cost of
all the associated issue. The grouped issues are subordinate issues to the main issue. They can be
created within an issue or move an existing issue as a subordinate issue. This feature also provides the
flexibility of seeing a roll-up cost of specific issues that can be tied to separate PCO/CCOs.

You can create main and subordinate issues in the following ways:

l Convert standard issue into a main issue with subordinate

l Add subordinate to main issue

l Make an existing issue into a subordinate of a main issue

Convert a standard issue into a main issue with a subordinate

1. Go to the Change > Issue Log tab.

2. Select an issue and then select the Subordinate issue icon.

3. Select Create subordinate.
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l The following box appears, indicating that a main issue is being created and the standard
issue becomes the first subordinate issue. 

4. Select Yes.

l The standard issue is now a subordinate issue and a main issue has been created

l The main issue becomes a rollup of all subordinate issues. The row becomes disabled as it
is a summary of the subordinate issues

l In the Main issue details, only Name and Description are editable. Subordinate issues are
all shown. On the details page, you can add or remove a subordinate from the main issue
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l Pricing is a read-only summary of the subordinate pricing

l Supporting documents shows supporting documents of all subordinate items

Add a subordinate to a main issue

1. In the project you have been using, navigate to Change > Issue Log tab.

2. Select the main issue and then select the Subordinate issue icon.

InEight Inc.  |  Release 25.9 Page 141 of 257

Change User Guide 4.12 Main and subordinate issues



3. Select Create subordinate.

l The Create subordinate issue window opens

A subordinate issue comes in as a new issue.

4. Fill in the required fields to complete this window.

5. Select Save.

l The subordinate issue will open its own record to be completed with the proper
information.
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Make an existing issue into a subordinate of a main issue

1. In the project you have been using, navigate to Change > Issue Log tab.

2. Select the main issue and then select the Subordinate issue icon.

3. SelectMake as subordinate from the list.

l The Make as subordinate issue window opens
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4. Select Issue ID/name to choose which Standard issue or Main issue this issue should be a
subordinate of.

5. Click Save.

l The issue becomes a subordinate issue

The Issue ID number changes from original issue number to a subordinate and is logged in
the Audit log. If this subordinate is ever removed from the main issue, it reverts to its
original Issue ID number.

4 . 13 ISSUE IMPORT

A convenient way to add multiple issues is through import using the issue import template. The issue
template includes the fields found on the issue Details page.

You can also export existing issues, make changes, and reimport the data.

4.13.1 Import the template

From the Issue Log, click the Import icon to begin downloading.
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The Import data from template dialog box opens for you to import and save the template or for you to
drop a completed template to be uploaded.

The template is an Excel spreadsheet. The first worksheet contains the Instructions for the template.
Here is where the legend and guidelines are located. The guidelines describe the information on the
Import template, exporting with data, and how to update or add more information to the existing data.
The second worksheet, Template, is where you enter your data for the issues. Drop-down fields are
populated from the organization and project settings. The only required fields are Issue name and
Issue start date. It is recommended to download a new template each time you import, so the fields
and field values are current. The columns are color coded to indicate which columns are system
generated, required data, optional data, and ignored data.

After you add your information and save the worksheet, you can import it.

Change validates the dates based on the person who imports the data. If the dates do not match
the preferences of that person, Change generates an error in the import history and deletes the
date. You must then enter the dates manually before you can complete the import.

Do not change the names of the spreadsheet tabs.

Import issues

Import issues into change when you want to quickly add multiple issues to the Issue log.
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The import template reflects the fields on the Issue Details page. It is recommended to download the
template each time you want to import issues, so the fields and field values are current.

1. From the Issue log, click the Import icon. The Import data from template dialog box opens.

2. Click Import issue template to download the template.

3. Open the Microsoft Excel template file, and then enter the issue information on the
Template worksheet. Do not change the name of the Template worksheet.

4. Click the Save icon at the top of the Template page.

5. Drag and drop or browse for the file to move it to the import data from template dialog box,
and then click Import. The data is imported, and the results are sent to you in an email
message when completed.

6. Open the email to view the results.

l If the status is Complete, the issues have been added successfully. If you want to review
the import you can click Review data to see a summary. The Import history page opens,
and the process is complete.

l If status is Pending, click Review data. The import history page opens. All errors are
flagged with a warning icon.

7. Correct any errors and make any other changes as needed. After you have corrected or updated
all fields, click Import.

8. The import is reprocessed, and the results are sent to you in an email message when
completed. If you want to see a summary, you can click Review data.

What's next: If workflow is turned on, issues come into Change with the status In approval, and they do
not get issue IDs until they are approved; the issue ID is Pending. Workflow emails are sent for each
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new issue included in import. If workflow is turned off, issue IDs are assigned upon import, and the
status is Not applicable.

4.13.2 Import issues through an API

You can import issues into Change using the Create Issues API. The API lets you consolidate all issues in
one place by importing issues in bulk or connecting to a third-party issue creation tool. For additional
information about the Create Issues API, refer to the API documentation in Resources > APIM
Documents and the InEight API Developer Portal.

4.13.3 Export the template with data

The export with data function lets you make changes to multiple issues by exporting the data to an
Excel template and then reimporting.

Click the Export icon, and then selectWith data to download a template. You can then make your
changes and then follow the procedures to import the issues.

4 . 14 SPL IT ISSUES

At times, you may have an issue that affects multiple lines of work, where it makes sense to split the
issue, so you can track the work more efficiently, effectively price it out, and view the impacts.

For example, the owner requests new access to a building and an issue is created. This involves rework
to the asphalt design, railing, and structure designs, so you decide to split the issue into several issues
to track each set of reworks separately.

The Split issue function is used to create multiple issues from one existing issue. When an issue is split,
the original issue is reidentified as X (Original) with subsequent splits being named X (B), X (C) etc.
(where X is the Issue ID number).

When a split is made, only issue details, supporting documents, associated vendors and status
are copied. Pricing values in the Pricing tab are not copied

The following steps walk you through how to split an issue into multiple issues.
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Split an Issue

1. From the Change page, on the Issue Log tab, select the check box for [your initials] – Bearing
Pads.

l The Split issue icon becomes available

2. Select the Split issue icon.

l The Split issue window appears
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3. Type 2 in the Total number of issues needed field to split the issue into two issues.

4. In the Why are you splitting this issue? field, type New bearing pad locations clash with deck
penetrations.

5. Click Split.

l On the Issue Log tab, your Bearing Pads issue is now two issues, parts A and B

l Note that while your original issue maintains it’s pricing details, your new issue’s pricing
needs to be defined

With your issue now split in two, the following Step by Step walks you through adding details to the
new issue, this time entering values at the Estimate level.
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Add details to a split issue

1. From the Change page, on the Issue Log tab, open the Bearing Pads (B) issue you created in the
previous step.

l The Bearing Pads (B) issue record opens

l Note the Details tab contains all the information from the original Bearing Pads issue

l You have easy access to the other issues related to the split under the Split issue section

2. Select the Pricing tab.

3. Complete the Estimate fields with the information below (issue is not required to have ROM
values completed):

l Estimate Self perform subtotal for Small tools & Supplies: $10,210

l Estimate Markup subtotal (create a new markup): $1,021
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l This is a 10% Markup on your directs

4. Add a vendor by selecting the Add vendor icon.

5. In the Estimate column for the newly created vendor, type 3,500.

6. In the Client pricing narrative text box, type Contractor agreed to re-use existing penetrations,
pricing is for labor only. If additional material is needed contractor will submit a cost-plus invoice
to client.

7. Click Save.

If you have ROM / Estimate values entered in the original issue before splitting the issue
and enter ROM / Estimate values in the newly created split issue B, you may need to
adjust the ROM or Estimate values on the original issue as it will still have the pricing for
the entire issue.
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4 . 15 COST ITEM PR IC ING

Cost item pricing lets you build an estimate using existing cost items from InEight Control or
unassigned items and then calculate an adjustment value based on an adjusted quantity using existing
current budget or current estimate rates. You can also associate a cost item to a vendor change order.
This provides easier estimating and continuous contract adjustment in Control and gives visibility into
how the estimates were derived. Refer to the Control documentation for more information about cost
items.

Cost item pricing is available at the issue level only.

Upon execution of a CCO, the cost pricing information goes to Control as a contract adjustment.
Assigned cost items automatically populate the contract adjustment to provide a more continuous
experience. Refer to the Control documentation for more information about budget and revenue
details from Change.

To access cost item pricing from an issue, click the Pricing tab.

4 . 16 PR IC ING TAB

The Pricing tab lets you add cost items to help you price the labor, equipment, and other expenses
related to resolving the issue.

VIDEO | Cost Item Pricing
The Pricing tab includes the following tools to help you complete the task.

Title Description

1 Filter Filters the grid by the selected value. You can filter as many
columns as needed.

2 Clear all
filters

Clears all filters in the grid.

Page 152 of 257 InEight Inc.  |  Release 25.9

4.15 Cost item pricing Change User Guide



Title Description

3 Group
columns

Lets you show cost items grouped by cost pricing type, UOM, or
pay item. For more information on column grouping, see Pricing
page organization tools.

4 Manage
columns

Lets you select the columns and their order in the grid. For more
information about column management, see Pricing page
organization tools.

5 View project
contract
summary

Opens the Project contract summary slide-out panel that shows a
view of the current project value, projected project value,
milestones, and allowance category.

6 Add
supporting
document

Opens the Add supporting documents dialog box that lets you
attach a document.

7 Row density Lets you choose the density of the rows from relaxed for easy
viewing, narrow, and tight to maximize the number of rows you can
see at a time.

8 Import Imports cost items from other sources. For more information
about importing cost items, see Import cost items.

9 Export to
Excel

Exports the cost item pricing into a Microsoft Excel spreadsheet.

10 Add note Lets you add a note about the pricing.

4 . 17 PR IC ING PAGE ORGAN IZAT ION TOOLS

You can use the column grouping and column management features to customize the grid, so you can
organize cost items for your business needs.

4.17.1 Group by column

When you add items to the Pricing page, they are added sequentially without grouping into categories.
Use the Group columns feature to show columns grouped by cost pricing type, UOM, or pay item.
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Group cost items by column on the Pricing page

Summary: Group by columns on the page when you want to see the cost items grouped by cost item
type, UOM, or pay item, instead of sequentially.

Considerations: You can group by one column at a time. If you want to change the grouping, you must
remove the column from the grouping area before adding a different column header.

1. From the pricing page, click the Group columns icon. The grouping area (a gray bar) shows above
the column headings.

.

2. Drag and drop the column header for the Cost pricing, Pay item, or UoM column to the grouping
area. The image below shows the Cost pricing column header.

The cost items show in labeled groups, including counts of the cost items in each group. The
following image shows the cost items grouped by cost item pricing type.

What's next: You can use column filtering as needed to narrow the cost items in the grid.
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4.17.2 Column management

Use the Column section builder to select and arrange columns in the Pricing page grid to show only the
columns you need. To access the Column section builder, click theManage columns icon in the
toolbar.

The Column section builder lets you arrange columns by either using the directional arrows or with
drag-and-drop editing. Transfer all to and Transfer all from directional arrows let you move all fields
between the Available columns and Selected columns panels. You can use the drag-and-drop feature
to move columns to and from the Selected columns panel and to change the column order. The Cost
item description and WBS phase code columns are in the locked columns section. You can change the
order of these columns within the locked section, but you cannot remove them from the locked
section. You can drag and drop additional fields to the locked section or remove them as needed.

To return to the original layout, click the Reset to default button at the bottom of the Column
selection builder.

You can also drag and drop columns if you need to arrange columns quickly without using the Column
section builder.
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4 . 18 ADD A COST ITEM

You can add an existing or new cost item. The cost item can be one of the following types:

l Plug – Unit and total costs are entered at the cost category level

l Detail – Resources are defined to determine costs

An existing cost item has already been established in InEight Control. When you add an existing cost
item, details are pulled from Control. When you add a new cost item, you must add the detail
information, such as UoM and a pay item. The detail information is added in Control when the CCO is
executed and approved in Control. See Edit cost items for information about the types of details that
can be edited for existing and new cost items. The number of cost items you can add is not limited in
an issue. However, if you convert the issue to a change order or use it in a budget move, you are
limited to 250 unique cost items or 100 unique pay items.

You can also add an unassigned pricing item that does not have a cost item associated to it. An
unassigned item has lump sum cost pricing by default.

You can use the icons in the left toolbar to add, edit, delete, or copy cost items. You can also right-click
in the grid to get a context menu with the same options. You can also import new plug items from a
Microsoft Excel spreadsheet into cost item pricing.

The fields that are available for you to add values to and edit depend on the cost item type and the
unit rate driver. See Edit cost items for information about editing plug and detail cost items.

Add an existing cost item

Add cost item pricing when you want to add detail to your pricing. Cost items are based on the CBS
structure from Control. The unit rate driver for an existing cost item defaults to the current estimate.
You can edit the unit rate driver after the cost item is added.

Only active terminal cost items are available for selection in cost item pricing.
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1. From the Cost item pricing page, click the Add cost item pricing icon.

2. Select Add existing cost items. The Add cost item pricing dialog box opens with the CBS
structure from Control. The cost items use the same color coding as they do in Control.

3. Select a cost item from the Select cost items section of the Add cost item pricing dialog box.
Available cost items have the Add icon. Parent WBS codes have a selection box that
automatically selects all the cost codes underneath it. You can use column choosers to select the
columns you need to identify the cost item. You also can remove items you do not want to see.
The cost item is added to the Select cost pricing pane, and the entry in the Select cost items
section is dimmed.

Repeat this step for each cost item you want to add.

4. Assign the cost pricing category (for example, labor or materials) by selecting the cost item
in the Select cost pricing section, and then choosing one of the options in the Cost pricing
column. If there are multiple cost items that are in the same category, select them, and
then click Group cost pricing.

After all cost items have a pricing category, the Add button becomes available.

5. Click Add.

InEight Inc.  |  Release 25.9 Page 157 of 257

Change User Guide 4.18 Add a cost item



Change pulls the following fields from Control:

l WBS

l Description

l UoM

l Forecast (T/O) qty

l Current CB Qty

l Mhrs/Unit

l Unit/Mhr

l Unit cost

l Cost source

l Resources

l Billing rate markup % (Calculated based on resource billing rates for cost source detail cost
items that have resources assigned with billing rate markups)

6. If you have the pricing information, enter a value in the Adjusted CB Qty column. Change
calculates the values for the Adjusted cost, Updated CB qty, and Adjusted man-hours fields, if
applicable, based on the current budget or current estimate rates. The value you enter in the
Adjusted CB Qty field cannot make the value in the Updated CB Qty field less than zero. Each
cost item defaults to current budget rates. If you change the Unit rate driver field from current
estimate to current budget, Change calculates the adjusted cost and adjusted man-hours based
on those unit rates. If you do not have the pricing information you can automatically calculate
values to get adjusted values from Control. See Auto calculate cost items for information about
automatically calculating cost items.

If a cost code is assigned to only one contract, Change automatically brings in that contract
association, so you do not have to look for the contract. The cost pricing defaults to Vendor, but
you can change it. After the cost item is added, Change automatically assigns the cost item to the
vendor and contract number. The vendor is editable.

A negative quantity can be entered if it is smaller than the Current CB Qty column. You
can use negative numbers in deductions so that Change calculates a true negative
deduction.
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7. Click Save. The cost items are added to the Cost item pricing page and the Pricing summary page.

The cost items can be edited from the Cost item pricing page. When you edit the description, it is
shown in the Cost item pricing grid, but is not carried over to InEight Control. The cost items are read-
only on the Pricing summary page.

Add a new cost item

Add a new cost item when you want to add detail to your pricing, but the pricing item does not exist in
Control.

If you are adding a plug cost item, the adjusted cost is driven by the values in the Details tab. After the
adjusted cost is calculated, the Cost categories tab shows a breakdown. If you are adding a detail cost
item, the adjusted cost is calculated using the resources on the Resources tab.

1. From the Cost item pricing page, click the Add cost item pricing icon.

2. Select Add new cost item. The New cost item slide-out panel opens.

3. Enter the description, and then indicate whether the cost item has a cost source of Plug or
Detail.

4. Enter the cost item information on the Details page.

l If the cost source is Plug, you can enter information in any of the fields.

l If the cost source is Detail, you can enter information in the Description, Adjusted CB Qty,
UoM, and Cost pricing fields only. The value you enter in the Adjusted CB Qty field cannot
make the value in the Updated CB Qty field less than zero. The other fields are populated
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after you have added resources on the Resources tab.

5. Click Apply. The pricing item is added to the Cost item pricing grid.

You can edit the cost item to add more information regarding resources or cost categories. After the
CCO is executed, you can see the newly created cost item in the Control contract adjustment. When
the contract adjustment is approved in Control, a WBS phase code is assigned. You can see the WBS
phase code in the CBS and the WBS number is reflected in the executed issue cost item pricing.

The cost item cost category in Control corresponds to the cost pricing section in Change the
item was assigned to. If there are any man-hours on the new cost item, that portion of the value
is allocated to the Labor cost category, and the remaining value to the category mapped to the
cost pricing selected.

Add an unassigned pricing item

Add a pricing item that is not assigned to a cost item in InEight Control.

1. From the Pricing page, click the Add cost item pricing icon, and then select Add unassigned
pricing item. The Add unassigned pricing item slide-out panel opens.

2. As a default, the Cost pricing is set to Lump sum adjustment. To change the cost pricing category,
select a new option from the drop-down list.
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3. You can optionally enter a description of the pricing item, the adjusted quantity, unit of
measure, adjusted cost, adjusted man-hours, and value type (ROM, Estimate, Agreed, Proposed).

4. Click Apply. The pricing item is added to the Cost item pricing grid.

4 . 19 ED IT COST ITEMS

If you want to add more detail for a cost item, select the item, and then click the Edit cost pricing
summary icon. The Edit slide-out panel includes tabs for details, cost categories, and resources.

4.19.1 Cost item details

The Details tab lets you edit the adjusted quantity and other information or the cost item. When the
Cost source is Plug, you can edit the adjusted cost. The Details tab also lets you view adjusted man-
hours pay item information for existing cost items.
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When the Cost pricing field is set to Vendor, you can assign a vendor to the cost item. To assign a
vendor, expand the drop-down list in the top right corner, and then choose a vendor.

4.19.2 Cost categories

The Cost categories tab shows the adjusted cost distributed across the cost categories. You can see the
adjusted cost, billing rate markup, billing amount, current budget, and current estimate.

When the Cost source is Plug, you can update the adjusted cost, billing rate markup, and billing
amount. Updating the adjusted cost affects other calculations. When you update the adjusted cost,
Change prompts you to choose whether to adjust the Labor cost/Mhr or Adjusted Mhrs calculation.

4.19.3 Resources tab

The Resources tab shows resources assigned to that cost item in InEight Control. The Resources tab
lets you add resources from the Control resources library.

4 . 20 ED IT PLUG ITEMS

4.20.1 Plug items

When the cost source is Plug, you can edit the following fields:

l Adjusted cost

l Unit cost

l Adjusted Mhrs

l Mhrs/Unit

l Unit/Mhr

l Labor cost/Mhr

These fields can be edited only in the Edit cost item slide-out panel. You can edit the Adjusted CB Qty
value from the Cost item pricing register.

The fields work interactively. If you change the value of a field, Change calculates the values of the
related fields. When you update the adjusted cost and there is a value in the Labor cost category,
Change lets you select the Labor cost/Mhr or the Adjusted Mhrs field to be recalculated. When you
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update the unit cost, Change calculates the adjusted cost, and then spreads the cost across all cost
categories.

If no quantity has been entered, you can enter an adjusted cost. The Mhrs, Mhrs/Unit, and Unit/Mhr
fields are disabled. After you enter an Adjusted CB Qty, all fields are enabled. Adjusting the man-hours
maintains the Labor cost/Mhr from Control to calculate the overall adjusted cost. After you make a
change, the Unit rate driver field changes to Manual. The manual changes are saved as an additional
unit rate driver when they are applied and saved to the register.

Initially, the cost item has a unit rate driver value of Current Budget, and you are prompted to enter
the Adjusted CB Qty. Afterwards, the adjusted cost uses the productivity rates to calculate the details
and Cost Categories tab. Adjusted MHrs, MHrs/Unit, Unit/MHr, and Labor cost/Mhr are used to
calculate the total Labor cost category.

The Cost categories tab in the Cost-item slide-out panel shows the assigned cost category assigned to
the plug cost item. The adjusted cost is placed into a cost category based on the cost pricing selected.
For example, when Cost pricing is Materials, the adjusted cost is shown in the cost category of
Materials. You can manually distribute costs across individual cost categories. All cost categories are
added together into a Total adjusted cost for the cost item. The name of each Cost category shown in
the tab can be modified using custom labels. When you update the Labor cost category, a dialog box
prompts you to choose to proportionally adjust the Labor cost/Mhr or the Adjusted MHrs value.

On the Resources tab, you can add or remove resources, but they do not affect calculations.

When the CCO is executed, Control consumes the updated quantity, cost, and man-hours in the
Contract adjustment.

4 . 21 ED IT DETA IL I TEMS

When the cost source is Detail, you can edit resources in the Resources section. Each resource has a
Cost driver of Fixed, CI Duration, or CI Qty as in Control. Cost driver and resource type determine which
fields are editable for any given resource. For example, when the resource has a Cost driver of CI
Duration exists, the Productivity and overall settings fields becomes editable.

Initially, the cost item has a unit rate driver value of Current budget, and you are prompted to enter an
Adjusted CB Qty. After that, the adjusted cost uses the productivity rates, based on the value of the
unit rate driver to calculate the values on the Details and Cost categories tabs. The Current budget and
Current estimate have their own Productivity rates for Unit cost, Adjusted MHrs, MHrs/Unit, Unit/MHr,
and Labor cost/Mhr, and cost category breakdown.
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l If the unit rate driver is set to Current Budget, only the Adjusted Qty is used to recalculate
productivity rates and cost category breakdown for the current budget.

l If the unit rate driver is set to Current Estimate, only the Adjusted Qty can be used to recalculate
Productivity rates and cost category breakdown for the current estimate.

If you add, edit, or delete a resource on an existing Detail cost item, the value of the Unit rate driver
field changes toManual to indicate that this cost item is no longer using current estimate resources
from Control. The option to return to the Current Estimate value becomes unavailable. The only way to
go back to the current estimate is to delete the cost item, and then add it again. Added resources are
indicated by a yellow circle to the left of the row number. Deleted resources show with strike-through
text. When a Contract adjustment is executed, Control does not consume any resource changes on the
existing cost items. This functionality is meant for estimating changes only.

After you change a value in the Resources section, a blue dot is shown to indicate that someone has
changed the value of the resource in Change. If you make changes to the Productivity and overall
settings section, a yellow indicator shows the last field that was updated. If the update to the
Productivity and overall settings affects resources, the blue dot is shown in resources.

When you undo a resource change, a dialog box prompts if you are sure you want to undo your
changes. If you select Yes, the changes are removed, and Change recalculates the cost item. For
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example, if you remove an existing resource and then you undo the removal, the strike-through text is
no longer shown.

Any manual change on the Resources tab (Resources or Productivity and overall settings sections)
changes the Unit rate driver toManual. When the Unit rate driver isManual, the cost item uses the
Resources tab to recalculate the cost item.

Each resource has costs distributed across the different cost categories that are shown in the Cost
categories tab. For Detail cost items, the Cost category tab is read-only.

4 . 22 COPY A COST ITEM

You can copy a new or existing cost item, so you do not have to start over when adding a similar item.
You can select Copy from the context menu or click the Copy icon in the toolbar.

You can select a new or existing cost item to copy. Only one cost item can be copied at a time. If you
have selected more than one cost item, the Copy cost item option in the context menu is disabled. You
cannot copy a copied cost item until it is saved. The copied cost item remains on the register when you
click Save.

Every copy is treated as a new cost item; therefore, a WBS phase code is not added because it is not
yet in InEight Control. The phase code stays blank until the CCO is executed and the contract
adjustment is approved.

4 . 23 COST ITEM PR IC ING TEMPLATES

4.23.1 Cost item pricing templates

When you have large projects with many cost items, or if you have a group of cost items that you use
on a regular basis, you can create a cost item pricing template to quickly add cost items to cost item
pricing. After you add an existing cost item, the Manage templates icon is enabled.

Templates are not specific to an issue. You can manage templates from any issue and reuse them.

Create a cost item pricing template from the register

Create a cost item template, so you can quickly add frequently used cost items when pricing an issue.

Only existing cost items can be saved as a template.
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1. From the Cost item pricing page, add an existing cost item.

2. Click theManage templates icon, and then select Create template. The Create as template
dialog box opens.

3. Enter the name of the template, and then select a value from the Sharing field drop-down list to
indicate whether the template is private or shared.
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4. Click Save. Change validates to ensure that the template name and shared value is unique. The
existing cost item dialog box opens. You can then select and group cost items.

The template can now be used to add cost items when pricing an issue.

Create a cost item template when adding cost items

You can create a template as you add cost items to cost item pricing.

Only existing cost items can be saved as a template.

1. From the Cost item pricing page, click the Add cost item pricing button or right-click anywhere in
the grid, and then select Add existing cost items. The Add cost item pricing dialog box opens.

2. Select one or more cost items, and then group them.

3. Click the Create template button. The Create as template dialog box opens.

4. Add the template name and indicate whether the template is private or shared.
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5. Click Save. Change creates the template, but the items are not added to the grid.

6. Click Add in the Add cost item pricing dialog box to add the items to the grid.

The template can now be used to add cost items when pricing an issue.

Add cost items from a template

You can use a template to quickly add cost items when pricing an issue.

1. From the Cost item pricing page, click theManage cost item templates icon, and then select
Manage templates. The Manage templates dialog box opens.

2. Select a template, and then clickOpen template. The Add cost items dialog box opens.

3. Optionally add or remove items from the Select cost pricing list.

4. Click Add to add the items to the cost item pricing grid.

4.23.1 .1 Manage templates

To manage a template, click theManage cost item templates icon and then selectManage templates.
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The Manage templates dialog box opens where you can add, edit, delete, and copy templates and send
a copy of a private template to another user.

You must have the Edit shared template permission to edit a shared template and the Delete
shared template permission to delete a shared template.

When you edit a template, you can only edit one template at a time. If you edit a shared template that
you did not create, you must create a new template with a unique name and then save it. You can
delete multiple templates at a time. When you delete a shared template, you delete it for all users.

You can copy a template and save it with a unique name.

You can send a copy of a template to another user.
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4.23 Step by Step 1 — Send a copy of a template

If you have a template you want to share with another user without making it a shared template for all
to use, you can send a copy.

1. From the Cost item pricing page, click the Manage cost item templates icon, and then select
Manage templates. The Manage templates dialog box opens.

2. Select a template, and then click the Send a copy icon. The Send copy of template dialog box
opens.

3. Enter the name of one or more users, and then click Send. The recipients receive a notification in
the Notifications area. When they click on the notification, they are taken to the issue log where
they can save the template.

4 . 24 DEPENDENT COST ITEMS

Dependent cost items are cost items with values calculated based on a percentage of the cost of other
items. Examples include insurance the company carries, bonds, and labor overhead. The value of the
cost item is calculated using the configured percentage and the adjusted billable amount of all items in
a section. For example, if you add a dependent cost item that is configured at 2% for the Labor section,
and the adjusted billable amount for all labor cost items is $4000, the dependent cost item value is
$80.

You can configure dependent cost items in the project level configurations (Settings > Configurations >
Dependent cost items), or you can add them manually.
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Add an existing dependent cost item

Add a dependent cost item when the value of a cost item is based on the values of other cost items in
the same section.

A dependent cost item must already be configured in the project settings.

1. From the Cost item pricing page, click the Add dependent cost item icon. The Add dependent
cost item dialog box opens.

2. In the Available dependent cost items section of the dialog box, click the Add icon for the
dependent cost item. The selected items are shown in the Selected dependent cost items section
of the dialog box. You can add multiple cost items.

3. Click Add. The dependent cost item is added as a line on the Cost item pricing page.

4. Click Save on the Cost item pricing page.

If a cost item for the section named in the cost item has already been added, Change calculates the
adjusted cost of the dependent cost item based on the adjusted costs of the cost items in the section.

InEight Inc.  |  Release 25.9 Page 171 of 257

Change User Guide 4.24 Dependent cost items



Add a new dependent cost item

When you want to add a dependent cost item, and it has not been configured, you can create it and
add it manually.

The dependent cost item is added to this cost item pricing only and is not available for future pricing. If
you plan to use a dependent cost item for multiple issues, it is best practice to define it in project
settings.

1. From the Cost item pricing page, click the Add dependent cost item icon. The Add dependent
cost item dialog box opens.

2. Click Add manual dependent cost item. A slide-out panel opens in the dialog box.
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3. Enter the dependent cost item information, and then click the Add to selected dependent cost
items button. The new cost item is shown in the selected cost items section. You can add
multiple cost items.

4. Click Add. The dependent cost item is added as a line on the Cost item pricing page.

5. Click Save on the Cost item pricing page.

If a cost item for the section named in the cost item has already been added, Change calculates the
Adjusted cost of the dependent cost item based on the adjusted costs of the cost items in the section.

Edit a dependent cost item

You can edit the Adjusted CB Qty for any dependent cost item or the Cost percentage for a manual
dependent cost item.

On the Details tab, the Cost percentage field for a manual dependent cost item and the Adjusted CB
Qty and Value type fields for any dependent cost item are the only editable fields. The remaining fields
on the Details tab and those on the Dependency and Cost Categories tab are for information only. The
Dependency tab shows the items that are used to calculate the dependent cost item. When you add a
dependent cost item to the grand total, the Dependency tab shows all cost items used to calculate the
value.
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The Cost percentage field in the Edit slide-out panel is disabled when the dependent cost item was
configured in the project settings.

1. From the Cost item pricing grid, select the dependent cost item, and then click the Edit icon. The
Edit slide-out panel opens.

2. On the Details tab, enter a new value in the Cost percentage field, if it is a manual dependent
cost item. If the field is disabled, the dependent cost item was configured at the project level and
cannot be edited. You can also enter an adjusted cost.

3. Click Apply. Change uses the updated cost percentage to calculate the value of the dependent
cost item. If you entered an adjusted cost, Change calculates the unit cost.

4. Click Save on the Cost item pricing page.

4.24.1 Edit dependent cost items

You can enable a project setting to allow users to edit the adjusted cost or cost percentage on
dependent cost items that were configured at the project level. To enable this setting, go to project
settings > Change > Configuration > Dependent cost items and set the Allow users to edit adjusted cost
items toggle to Yes.

When the toggle is set to Yes, users can edit the Adjusted cost field, and then the Cost percentage field
is automatically recalculated and vice versa.

4 . 25 MARKUPS

You can add a markup to any cost item. Markups can be applied to any section, including the grand
total. After the cost item is saved, the markup is carried over to the pricing page and is included in the
subtotals for each section. They are also included in the Markup field in the issue header.
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Markups can be based on a percentage, or they can be a specified markup. When you specify a value
markup, you can specify the amount of the markup. That value is applied regardless of the amount in
the cost item sections. Value markups are always level 0 and can also be applied to the grand total at
level 0. For information about markups based on percentages, see Markups. For information about
markup levels, see Markup calculation levels.

The following image shows the cost item pricing with a 100% markup percentage and a markup value
of $100 in the Labor section, a value markup of $100 in the equipment section, and a value markup of
$200 dollars in the grand total.

Value markups are included in the grand total summation before the grand total is multiplied by the
percentage based markup. For example, the image below shows a grand total for an adjusted cost of
$5000. A 10% percentage markup ($500) and a $60 value markup are applied at level 0. The 5%
markup at level 2 is calculated from $5560, which is the adjusted cost plus the two level 0 markups.

Cost item markups are carried over to the pricing summary. The cost item markups are shown above
the subtotal line and are included in the pricing summary subtotal.
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After you convert the issue to a potential change order or client change order, both the cost item
markup and the pricing summary markup are shown above the subtotal in the potential change order
or client change order.

Add a percentage-based markup to a cost item

Summary: Add a percentage markup when you want to mark up cost items based on their values.

Considerations: Percentage markups are only calculated when a cost item has a value.

Quick steps:

1. From the Cost item pricing page, click Add markups, and then selectMarkup percentage. The
Add markup dialog box opens.
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2. Select an available markup, or click Add manual markups to add a new one. When you add a
new markup, a slide-out panel opens in the Add markup dialog box that lets you add a markup
name and percentage. The markup percentage can include up to three digits before the decimal.
You can then select the section to which it is applied and the markup level, if applicable. Click
Add to selected markups to add the markup.

3. Click Add. The markup is shown in the grid on its own line.

Add a value markup to a cost item

Summary: Add a value markup to a cost item when you want the markup to be a set amount and not
based on the values of the cost items in that section.

Considerations: Because the value markup is a set amount, it is added to the cost item section
regardless of the value of the cost category. Value markups are always level 0.

Quick steps:

1. From the Cost item pricing page, click Add markups, and then selectMarkup value. The Add
markup dialog box opens.

Enter the markup name, the value of the markup, and the section it applies to. The markup level
is set to Level 0 and cannot be changed.
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2. Click Add to selected markups.

3. Optionally, repeat steps 2 and 3 if you want to add additional value markups.

4. Click Add to add the markups to cost item pricing. The markup is shown in the grid on its own
line.

You can also add markups at different calculation levels to the grand total. See Markup calculation
levels for more information.

4 . 26 AUTO CALCULATE COST ITEMS

The Change auto calculate feature lets you start your cost item pricing work with the most current
adjusted values from InEight Control. With auto calculation, changes to the current estimate in Control
populate change order values, resulting in matching CE and CB values after the change order is
completed.

The auto calculate feature subtracts the current budget from Control from the current estimate in
Control to update the adjusted CB cost in Change. When you auto calculate a value, other values
associated with the value are also adjusted. For example, if you recalculate the adjusted quantity, the
unit cost changes. When you recalculate man-hours adjusted man-hours, man hours per unit, unit per
man-hour, and labor cost per man-hours are updated.

Auto calculate cost items

Summary: Using auto calculated cost items is helpful in the early stages of cost item pricing when you
might not have access to budgets, estimates, and cost categories. Change calculates the adjusted
values from current budget and estimate values from Control.
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Considerations: Auto calculate is for existing plug cost items only. If you recalculate a detail cost item,
Change shows a message saying it will change the detail cost item to a plug cost item. Auto calculate is
not available for new cost items, dependent cost items, or markups.

The recalculation uses the values from Control. Values previously entered in Change are overwritten by
values from Control.

Quick steps:

1. From the Cost item pricing page, select a cost item, and then click the Auto calculate icon. The
Auto calculate dialog box opens.

2. Select the fields you want to match the current budget values with the current estimate values.
You can select multiple values. When you select Cost or Select all, Change recalculates the cost
categories. Click Apply. Change recalculates the cost item.
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4 . 27 ASSOC IATE A PR IC ING ITEM TO A
VENDOR CHANGE ORDER

If your environment includes InEight Contract, you can associate vendor pricing items to a vendor
change order (VCO) in Contract. Associating the pricing item to a VCO while in Change saves time and
prevents entry errors. You can associate a vendor pricing item to an existing Contract VCO, or you can
create a new VCO.

Associate a vendor pricing item to an existing Contract VCO

Associate a vendor pricing item to an existing VCO when you know that a VCO in Contract already
exists. Associating the pricing item from the Pricing page can save you time. Instead of opening
Contract, you can associate to an existing VCO directly from the Change Vendor and pricing
information.

The vendor must already be added to the cost item. If the Vendor has another pricing item on the issue
associated to a VCO, all of that vendors cost items for this issue will automatically be associated to the
same VCO. A value in the Vendor Change order ID- Description column on the pricing grid indicates
that a VCO has already been created. For information about adding a vendor to a cost item, see Edit
cost items.

1. From the Pricing page, select a cost item with the Cost pricing value Vendor. The Associate to
Vendor Change order icon in the tool bar shows as enabled. If the icon does not show as
enabled, the cost item is not associated to a vendor or already has a VCO associated to it.

2. Click the Associate to Vendor Change order icon. The Associate to Vendor Change order dialog
box opens.

3. Select Existing as the Vendor Change order type. Enter the Vendor Change order ID.
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4. Click Add. Information from the VCO populates the fields in the pricing item grid on the Edit
vendor and pricing information slide-out panel.

Create a VCO in Contract

You can create a new VCO in Contract and associate a pricing item to it when the VCO does not already
exist. This task adds the VCO to the Contract VCO log and associates the pricing item to it.

A contract for the vendor must already exist in Contract.

1. From the Pricing page, select a cost item with the Cost pricing value Vendor. The Associate to
Vendor Change order icon in the tool bar shows as enabled. If the icon does not show as
enabled, the cost item is not associated to a vendor.
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2. Click the Associate to Vendor Change order icon. The Associate to Vendor Change order dialog
box opens.

3. Select New as the Vendor Change order type.

4. Enter the VCO information. The Vendor Change order number, Description, and Vendor Change
order type fields are required.

5. Click Add. The VCO is added to the vendor contract in Contract, and the pricing item is
associated to it.

The VCO is listed on Contract's Vendor Change order log for the vendor's contract.

4 . 28 IMPORT COST ITEMS

Importing cost items from other sources, such as a Microsoft Excel spreadsheet or from InEight
Estimate can save time and reduce errors when adding cost items to cost item pricing.

4.28.1 Import cost items from an Excel spreadsheet

When you need to add a large number of plug cost items to cost item pricing, you can add them to an
Excel template, and then import them into Change. The import function lets you import new and
existing cost items with the cost source Plug into cost item pricing. Any plug cost item that is in the
current project is eligible for import.

If you import an existing cost item, the description that is configured in InEight Control is imported by
default. To change how the description of the cost item is shown in Change, enter a new description in
the Description field of the template. When the Description field is blank, Change uses the description
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provided by Control. In the following image, the cost item with WBS phase code 1064 has no updates
to the description, so the description from Control is imported. The item with phase code 1063 has a
new description for this project. A new cost item has also been added on line 6.

The next image shows the items after they have been imported into cost item pricing. The new cost
item has been added, the item with phase code 1063 shows the new description, and the item with
phase code 1064 shows the description from Control.

Change also calculates the Man-hours per unit, Units per man-hour, and Labor cost per man-hour
fields using the Adjusted CB Qty, Adjusted Mhrs, and Labor Adjusted cost values. In the template image
above, line 7 shows an Adjusted CB Qty value of 10, Adjusted Mhrs value of 20, and a Labor Adjusted
cost of 600. The following image shows the calculated Mhrs/Unit and Unit/Mhr values. To see the
Labor cost per man-hour, click the Edit icon.
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Import Plug cost items

Importing cost items can save you time when you have to add a large number of cost items. You can
enter the items into an Excel template, and then import them into Change.

The import function is for new and existing plug cost items only. If you have changes to make to
existing items, you must edit them instead of importing new ones. If you enter a WBS phase code, you
must use a code that already exists in Control. New cost items do not have a WBS phase code, and the
field in the template must be left blank.

The Excel template reflects the current settings for the organization and project. It is recommended
that you download a new template each time you import items. You can refer to the Instructions tab of
the template for information about importing, validations, and limitations.

1. From the Cost item pricing page, click the Import icon in the toolbar. The Import data from
template window opens.

2. Click Import cost item template to download the template.

3. Open the template, and then add the plug cost items to the template. The columns with orange
headers are required. To change the cost category distributions of existing cost items, enter the
value in the corresponding field of the template.

Do not change the names of the spreadsheet tabs.

4. Save the template with a unique name.

5. Drag and drop the template to the Import data from the template window, and then click
Import. After importing, you receive an email message listing status, the total cost items, the
total imported, and number of errors.

6. If the status is Pending, you can click the Review data link to see the cost items that have
completed and those with errors. If the import details page shows an error in the WBS phase
code column, you can use the drop-down list to select a valid WBS phase code.

7. Correct the cost items with errors from the Import history grid, select them, and then click
Import to continue with the import process. The import is reprocessed, and Change sends you
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an email message when the import is completed.

If there is an error in an interdependent field such as an adjusted cost, the Import history
grid shows an error for every related field. When you correct the error in one field, the
others automatically recalculate but might still show an error if you did not click in those
fields. After you correct the original error, you can click Import.

You can view the import history for cost item pricing by selecting View import history from the Actions
menu.

4.28.2 Import cost items from Estimate

An Estimate user can publish cost items that you can then import into Change. Before an Estimate user
can publish the cost items, Estimate must be integrated with Change. Refer to the InEight Estimate
Integration to Change document for information about integration.

After Estimate has been integrated with Change, the Estimate user can publish the cost breakdown
structure (CBS) to Change. The CBS file can contain both Plug and Detail cost items, but only Plug items
are imported to Change.

You can access the published file from the Import history page for any issue in the project. The file can
only be consumed one time in Change.

On the Import history page, the file name for the imported file is the Estimate project ID followed by
the Estimate project description. The file location is InEight Estimate, and the status is Pending. You
can then click the link in the Status or Total records column to select the file.

The cost item pricing items are imported with the Import status of Error in the import history Details
page because they do not have a Cost pricing value assigned. You can select cost pricing values for the
cost items you want to import to the issue. Any cost item that does not have a Cost pricing value
selected is not imported.

Each cost item has a WBS code of New. They are assigned WBS phase codes after they are executed in
a client change order (CCO).
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Import cost items from Estimate

Summary: Import cost items into Change after the cost items are exported from Estimate, so you can
use them for cost item pricing in an issue. Refer to Cost items for change managementin Estimate for
more information about publishing files to be imported into Change.

Considerations: These steps start after the project file has been published from Estimate.

Because the imported file can only be consumed one time in Change, if you want to use cost items that
were not imported in another issue, the file must be published again from Estimate.

1. From an issue's Cost item pricing or Pricing tab, open the Import history page (Pricing > Cost item
pricing> Actions > View import history), and then click the link in the Status column to open the
import history details page.

2. From the history page, select the cost pricing type for each cost item you want to import.

3. Click Import. Only the items that have no cost pricing type errors are imported. Values on the
cost item's Details and Cost categories tabs are imported with the cost item. The items show in
cost item pricing with a WBS code of New.

What's next: Change sends a confirmation email when the import is complete.

4 . 29 COST ITEM SYNC

Change takes a snapshot of the cost item from Control at the time it is added. Any updates made to
the cost item in Control are not automatically reflected in the pricing. This is to ensure pricing is not
changed without the Change user knowing or completing an action. If you want to update cost items
from Control, you can sync each cost item individually or in groups.

To sync an individual cost item, click the Edit icon, and then click Get cost item in the slide-out panel.
The cost item is updated with any changes made in Control. Updates are also reflected in the Issue log.
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To sync multiple items, go to Actions > Sync > Get cost items. The Get cost item dialog box shows a list
of cost items that have changed in Control since they were originally added to the Cost item pricing
page. This dialog box shows before and after comparisons based on the current unit rate driver.

Not all fields show in this dialog box as fields that have been modified. For example, if current
estimate rates have been updated in Control, and you are using the current budget rates for
your pricing, the changed fields would not be listed.

The Synced date column on the cost item pricing grid shows when information was pulled from
Control.
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4 . 30 PR IC ING SUMMARY

The Pricing summary is used to collect pricing information related to your issue, so you can manage
and track the current estimate price and see a progression of your pricing totals from rough order of
magnitude (ROM) to Agreed. The Pricing Summary tab can be used to record high-level pricing
information or more detailed information on the Pricing page using cost item pricing. If you have more
detailed pricing information related to the issue (for example, pricing sheet, pricing change from
estimate, quote from sub), you can attach it to the issue under the Supporting Documents tab.

The Pricing summary tab includes the following tools to help you complete the task.

Title Description

1 View project
contract
summary

Opens the Project contract summary slide-out panel that shows a view of
the current project value, projected project value, milestones, and
allowance category.

2 Jump to
pricing
section

Lets you jump to a section of the Pricing page without scrolling.

3 Add
supporting
document

Opens the Add supporting documents dialog box that lets you attach a
document.

4 Row density Lets you choose the density of the rows from relaxed for easy viewing,
narrow, and tight to maximize the number of rows you can see at a time.

5 Export to
Excel

Exports the pricing information, including cost item pricing, into a
Microsoft Excel spreadsheet.

6 Add note Lets you add a note about the pricing.

7 Show Pricing Opens the Pricing summary page from the Cost item pricing page.

 Pricing tab – tools
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Title Description

summary

8 Show Cost
item pricing

Opens the Cost item pricing page from the Pricing summary page.

 Pricing tab – tools (continued)

The Pricing summaryregister records the total costs related to the issue that you potentially would
propose to the client, should it become a change order. The Pricing summary is organized into Direct
cost total, Vendor total (if you’ve added a vendor), and Indirect cost total.

The register is organized by five value types in order of precedence:

l ROM (rough order of magnitude) –This is a quick rough estimate and is an estimation of a
project’s level of effort and cost to complete

l Estimate – Actual estimated price

l Proposed – This is the price proposal given to a client. In most cases, the estimate can be the
proposal (Proposed).

l Agreed – Client agreed price

l Contributed values – This is the value taken from the farthest to the right of all value types. For
example, if there is a price in ROM and a price in Proposed, the Contributed value equals the
Proposed price
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If you have subtotals for each of these values, the Contributed value always takes the value furthest to
the right. For example, if you have $12,000 in Estimate, and $9,000 in Agreed, the Contributed value is
$9,000.

As another example of pricing, you have an issue for which you originally calculated a rough order of
magnitude (ROM) of $1,000 for Labor. You then priced the issue in your estimating system and came
up with an Estimate value of $800. Finally, you worked with the owner and came to an Agreed value of
$500. You enter these values into the Labor fields.

You also have two lines of $100 each for Materials. One is a ROM, and one is an estimate. You do not
have an Agreed price for Materials. Your subtotal value that is furthest to the right contributes to your
Contributed values.

The values furthest to the right also contribute to the totals (such as the Direct Cost total) and the
Current value.

Values shown in dimmed text are summary values from the cost item pricing page and are read-only.
See Cost item pricing for more information about these items.

4.30.1

4 . 31 D IRECT COST TOTAL

4.31.1 Direct cost total

The direct cost total has sections for Labor, Equipment, Materials, and Small tools & supplies. Each
section can have multiple lines to help you break pricing down into further detail.
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Each line contributes to the category subtotal, and then each subtotal contributes to, or rolls down
into, the Direct cost subtotal. A markup for a section rolls down to the Direct cost subtotal. Markups to
the Direct cost subtotal roll up to the Direct Cost total.

See Markups for more information about markups.

4 . 32 VENDOR TOTAL

You can add vendors directly from the Pricing summary in the Vendor total section. When you click the
Add vendor icon, the Add Vendor dialog box opens, and you can choose from a list of available
vendors to include in your Pricing Summary.

You can add a temporary vendor from the Pricing summary section if they are not listed as an available
vendor. A temporary vendor might not have a contract in the system yet or might not yet be available
in your ERP system.

You can select a vendor that is already associated with the issue, PCO, or CCO, or you can manually
enter a temporary vendor name and select Add to selected vendors. Vendors can also have more than
one pricing item.
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As a best practice, generic names such as temporary vendor, or temp vendor should not be
used. The actual name of the temporary vendor should be used.

Click the Add button to create the temporary vendor.

After you select Add, the new temporary vendor is automatically shown under the Pricing summary >
Vendor subtotal section of the page.
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After you receive a contract from the vendor, you can select the Edit icon to make additional
changes and replace the actual contract that is reserved for this vendor.

4 . 33 ED IT VENDOR INFORMAT ION

To edit vendor information, select the Edit vendor and pricing information icon in the vendor line. The
Edit vendor pricing information dialog box is shown below.

In the Edit vendor pricing information dialog box, you can then change the vendor or add the RFP
status, vendor notes, pricing items or cost items. If you used a temporary vendor, you can replace it in
the Edit vendor pricing information drop-down field, as shown in the image below.
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After you replace the temporary vendor to the newly assigned vendor in the Edit vendor and
pricing information drop-down list, all the temporary vendors are replaced with the newly
assigned vendor. It is important not to use generic temporary vendor names such as temporary
vendor, or temp vendor. This action cannot be undone.

After you click Apply, a message opens stating that all issues that contain the temporary vendor name
will be replaced with the newly selected. Click Yes to accept.

With the vendor added, you can record pricing. This includes ROM, Estimate, Proposed, and the value
you agree upon (Agreed). The value farthest to the right for each line is used in the Contributed values
column.
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The vendor’s subtotals populate in the Contributed values and are reflected in the Grand total for the
issue, which also becomes your Current Value.

Cost items that have a cost pricing of Vendor, come in as individual lines in the Vendor section as
temporary vendors. Click Edit to assign the temporary vendor to an existing contract vendor. If that
vendor already exists on the pricing summary page, the pricing items are combined under the vendor.

After a CCO is executed, only the Vendor field is editable, so you can replace the temporary vendor
with the current vendor.

4 . 34 VENDOR CHANGE ORDERS

If your environment includes InEight Contract, you can associate vendor pricing items to a vendor
change order (VCO) in Contract. Associating the pricing item to a VCO while in Change saves time and
prevents entry errors. You can associate a vendor pricing item to an existing Contract VCO, or you can
create a new VCO.

Associate a vendor pricing item to an existing Contract VCO

Associate a vendor pricing item to an existing VCO when you know that a VCO in Contract already
exists. Associating the pricing item from the Pricing summary can save you time. Instead of opening
Contract, you can associate to an existing VCO directly from the Change Vendor and pricing
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information.

The vendor must already be added to the Pricing page. The vendor must not have pricing items that
have already been associated to a VCO. A value in the Vendor Change order ID- Description column on
the pricing grid indicates that a VCO has already been created.

1. Click the Edit vendor and pricing information icon for a vendor. The Edit Vendor and pricing
information slide-out panel opens.

2. Select one or more pricing items. The Associate to Vendor Change order icon becomes enabled.

3. Click the Associate to Vendor Change order icon. The Associate to Vendor Change order dialog
box opens.

4. Select Existing as the Vendor Change order type. Enter the Vendor Change order ID.

5. Click Add. Information from the VCO populates the fields in the pricing item grid on the Edit
vendor and pricing information slide-out panel.
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Create a VCO in Contract

You can create a new VCO in Contract and associate a pricing item to it when the VCO does not already
exist. This task adds the VCO to the Contract VCO log and associates the pricing item to it.

A contract for the vendor must already exist in Contract.

1. Click the Edit vendor and pricing information icon for a vendor. The Edit Vendor and pricing
information slide-out panel opens.

2. Select one or more pricing items. The Associate to Vendor Change order icon becomes enabled.

3. Click the Associate to Vendor Change order icon. The Associate to Vendor Change order dialog
box opens.

4. Select New as the Vendor Change order type.

5. Enter the VCO information. The Vendor Change order number, Description, and Vendor Change
order type fields are required.

6. Click Add. The VCO is added to the vendor contract in Contract, and the pricing item is
associated to it.

The VCO is listed on Contract's Vendor Change order log for the vendor's contract.

4 . 35 IND IRECT COST SUBTOTAL

The Indirect cost subtotal section contains the time related overhead, fixed indirect, and non billables
summaries. These summaries are added together (rolled down) to get the indirect cost subtotal. You
can add multiple lines to each section and apply markups.

4 . 36 MARKUPS

You can add a markup to any subtotal. Markups apply to the subtotal of each selected section, then
roll up to an overall section total. For example, if there is a 1% markup for labor, and a 10% markup for
the direct total cost, a $15,000 line in the labor section has a markup of $150, which makes the labor
contributed value $15,150. The direct cost markup is 10% of the $15,150, so $1,515 is added to the
direct cost subtotal for a total of $16,665. Any markups from cost item pricing are included in separate
lines above the subtotal.

InEight Inc.  |  Release 25.9 Page 197 of 257

Change User Guide 4.35 Indirect cost subtotal



All markups are located directly underneath the subsection and apply to the level (that is, Issue, PCO,
or CCO) you are applying them in. In a PCO, the markups from the issue are above the PCO subtotal
line, and the markup added at the PCO is below the subtotal. This is because multiple issues can be
collected into a PCO, and then a PCO level markup is applied to all the associated issues. The following
image shows the issue-level markups and new markups at the PCO level.

In a CCO, the markups from the issue and the PCO are above the CCO subtotal line, and the markups
added at the CCO is below the subtotal, so you can collect multiple PCOs into a CCO and then apply a
CCO level markup to all the associated PCOs.

You can hover over markups in a PCO or CCO to see level where the markup has been added to give
you visibility. Markups are indicated by orange arrows. If you hover over the arrow, you can see the
type of markup, the name or ID, and the markup amount.
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To add a markup, click the Add markup icon at the top of the page. The Add markup dialog box opens,
and you can select from available markups or add a manual markup. A markup can have up to three
digits before the decimal.

You can also add markups at different calculation levels to the grand subtotal. See Markup calculation
levels for more information.

4 . 37 DEDUCT IONS

The Deductions section lets you reduce or allocate value to one or more specific cost items. The
Deduction value can only be populated from the Cost item pricing tab and produces a net value of
overall change issue. For example, for a current value of $10,000 with deductions of -$7,500, the net
value is $2,500. To produce a negative deduction, you must use a negative quantity.

4 . 38 MARKUP CALCULAT ION LEVELS

When you want a markup in the Grand total section of the pricing summary or cost item pricing to
consider previous markups, you can add markups at different calculation levels. Change adds the value
of lower-level markups to the grand total to calculate the next level markup.

Markups can be set at levels 0 through 4. Level 0 is considered the root level. The markups are based
on the grand total in a cost item or grand subtotal in the pricing summary and show below those lines.
Markups to other sections are also considered level 0. Markups for subsequent levels are calculated
from the subtotal plus markups from lower levels. For example, if markups in cost item pricing are 1%
for levels 0, 2 and 4; 2% for level 1; and 5% for level 3, and the grand total is $1000, Change calculates
the values as follows:

l Level 0: $1000 x 1% = $10
l Level 1: $1010 x 2% = 20.20
l level 2: 1030.20 x 1% = 10.302
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l level 3: 1040.502 x 5% = 52.025
l level 4: 1092.527 x 1% = 10.925

The total markups to the grand total in cost item pricing is 103.452.

The various markups from cost item pricing are shown in the grand subtotal in the pricing summary.
When multiple markup levels are added to the grand total in the pricing summary, they show under
the grand total. Markup levels can be added to the pricing summary at the issue, PCO, and CCO levels.
The following image shows the Pricing summary page with the markup levels from the above example
and two levels of markups added from the pricing summary.

4 . 39 BUDGET MOVES

When you have issues that are not going to result in client change orders, you can now initiate a
budget move in InEight Control directly from the issue, so the value can be moved to another part of
the budget.

4.39.1 Initiate a budget move

When the integration is enabled, a budget move from Change automatically creates a budget move
entry in the Change Register in Control. When the Control user creates a budget move, the attributes
that were set up in Change flow into Control.

To create a budget move from an issue, click the Actions menu, and then select Submit budget move.
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In a budget move, an issue is limited to 250 unique cost items or 100 unique pay items. If a message
shows indicating that you must remove cost items or pay items, it is best practice to create a new
issue. Creating a new issue lets you create another budget move with the removed cost items and pay
items.

A budget move is sent to Control with a Draft status. After the budget move is sent to Control, the
issue is given a status of Budget move. You cannot associate the issue to a PCO or CCO, and the Pricing
tab is disabled. The Control user can review, revise, or delete the budget move. If you make a budget
move that is not zero, the Control user can zero out the budget move.

You can track the budget move from the Control budget change section in the Additional details
section of the Issue details.

The heading of the Control budget change section shows the Control icon representing the budget
move status. The budget move in Control can have one of the following statuses: Approved, Draft,
Revised, or Rejected.
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4.39.2 Budget move workflow

If workflow is configured for the budget move, the budget move must be approved in Change before it
can be sent to Control. The workflow begins after you select Submit budget move from the Actions
menu. The Start approval dialog box opens, where you can add a message or attach supporting
documents before starting the workflow.

After the workflow has begun, the issue is locked, and no edits can be made while the budget move is
pending approval. If the budget move is recalled or rejected, the issue is enabled for editing.

4.39.3 Revise a budget move

If circumstances change, and you need to edit the issue, you can revise the budget move. To revise the
budget move, click the Actions menu, and then select Revise budget move.

The status in the Control budget change section changes to Revised. You can then make changes to the
pricing or associate the issue to a PCO or CCO.

4 . 40 TASK CREAT ION IN INE IGHT
COMPL IANCE

When you have tasks associated with an issue, PCO, or CCO, you can create them in InEight
Compliance to take advantage of Compliance's task management features. The task is created in
Compliance and is completed in the issue, PCO, or CCO.
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4.40.1 Compliance integration

Before you can create tasks for Change in Compliance, you must ensure that Compliance task
templates are in place and permissions are set up for you in Compliance.

4.40.1 .1 Permiss ions

You must have permissions to create task in Compliance. Permissions for Change users who are
allowed to create tasks include access to the following:

l The project or organization

l The category for the template the organization uses

l The reporter role for creating and editing tasks

4.40.1 .2 Compl iance task templa te

The task you create in Change follows the default task template. An administrator can create a task
template in Compliance. The template must have the following:

l Task title

l Change ID

l Description

l Task person

l Due date

l Assign button

l Notes

l Complete button

l Cancel button

The template must be published before it can be used in Change. Refer to the Compliance
documentation for information about how to set up a standard task template.

The template must then be selected in the organization settings (organization Settings > Change >
Configurations > Task type setup). The selected template is used for all projects in the organization.

4.40.2 Create a task

You can create a task from the Details page of an issue, PCO, or CCO.
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Create a task

Create a task in an issue, PCO, or CCO when you have task items that you want to follow up.

A task template must be in place, and you must have permission to create tasks in Compliance.

1. From the Details page of an issue, PCO, or CCO, expand the Actions menu, and then select
Create Task. The template opens in Compliance in a new window.

2. Enter information in the required fields, and then click Assign. The Task log in compliance opens,
and you can see your task in the list.

The task person completes the task, and then clicks Complete. You can track the task progress in the
task log and on the Details page where you originated the task.

4.40.3 Task log

After work has begun on a task, it becomes available on the Change Task log. The Task log (Change >
Task log) shows the tasks assigned to the project. A red circle icon indicates the number of tasks in the
project that are pending, scheduled, or overdue.
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The task log shows all tasks that have been assigned on the project. The View drop-down menu in the
upper right of the page lets you change the view to show your tasks only. You can also change the row
density.

Values in the ID column are links to the originating issue, PCO, or CCO. The Task title is a link to the task
in Compliance. The Due date and State columns highlight tasks that are past due in red. The Name
column contains the Name of the issue, PCO, or CCO.

You can click the Export icon to export the tasks to a Microsoft Excel spreadsheet.

You also can view tasks from the issue, PCO, or CCO in the Task section of Additional details. See the
Additional details for issues, PCOs, and CCOs for more information about the Tasks section.
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CHAPTER 5 — CHANGE ORDERS

Features in Change help you create and manage potential change orders and client change orders.
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5 . 1 INE IGHT CONTRACT WORKFLOW –
CHANGE ORDERS

5 . 2 POTENT IAL CHANGE ORDER (PCO)

5.2.1 Overview

During the process of managing changes, some of your issues will require additional work for either
you or your subcontractors to perform. As you seek compensation from the client (owner) for issues
that require additional work, you will convert those issues into Potential Change Orders (PCOs), as
indicated in the below workflow.

The table below further defines each step of the change management process.

Term Description

Issue Something that happens on the project that could incur costs or impact the
schedule.

l Provides a way to track issues that may or may not become a
contract change (PCO or CCO)

l You can track how many issues occurred on the project, what their
impact was, and how many were recovered via change orders 
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Term Description

Potential
Change Order
(PCO)

A potential change to the owner’s contract that you are pricing and getting
ready to negotiate with the owner.

l A PCOmay contain one or more issues
l A PCOmay go through several changes during the negotiation with
the owner

l You can track PCOs to see the potential effects on your budget and
revenue

Client Change
Order (CCO)

A finalized change you are ready to send to the owner.
l You can bundle multiple PCOs together to become one CCO

5.2.2 Potential Change Order (PCO) Creation

A PCO is generated from one or more issues that already exist within the issue log. The PCO will carry
over all pertinent data from the Issue and populate the fields within the PCO. The link between Issue
and PCO is one-way, upstream. Data carried over from the Issue into the PCO can be modified without
any changes occurring to the original data, however, changes to the Issue can be pushed upstream to
the PCO.

Any changes made to PCO pricing does not update the original issue. If an issue needs to be
updated, you will need to open the issue and update it.

The following steps walk you through how to convert an issue to a PCO.

Create a potential change order (PCO)

Summary: Create a PCO when you are ready to negotiate the issue with the owner.

Considerations: These steps start from the Issue log. You can also create a PCO from the Change orders
section of the issue Details page. If your contract is already negotiated with the owner, you can convert
an issue directly to a CCO and skip the PCO process altogether.

When converting to a change order, an issue is limited to 250 unique cost items or 100 unique pay
items. If a message shows indicating that you must remove cost items or pay items, it is best practice
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to create a new issue. Creating a new issue lets you create another change order with the removed
cost items and pay items.

Quick steps:

1. From the Issue log , select the issues you want to convert to a PCO.

2. Click the Associate to change order icon, and then select Assign to potential change order.

If any of the issues you selected are already part of a PCO or CCO, you will receive an error
message. You can check the Issue Status column in the Issue Log to ensure the selected
issues have a status other than PCO or CCO.

The Assign to potential change order dialog box shows.

3. Indicate whether the issue is to be associated to a new or existing PCO, and then enter the PCO
ID and PCO name. You can also enter an alternate PCO ID and a description of the change.
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4. Click Save. The PCO Details page opens.

5. Optionally, scroll to the Associated issues section, and then add any additional issues you want
to associate to the PCO.

6. Go back to Change > PCO Log to see the status of your newly created PCO.
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5.2.2 .1 Ass ign a PCO from Issue Record

Another option for Assigning an issue to a potential change order is on the Details tab of an issue
record. Clicking the Assign to potential change order link will open the window to assign the issue to a
PCO.

5.2.3 PCO Header

The header at the top of your PCO record contains the same functionality as the issue header, allowing
you to update the following:

l PCO status

l Pricing status

l Proposal status

As you change the statuses, you will be prompted to enter notes. These notes are stored in the Notes
slide out panel, which you can access at any time by clicking on the View notes icon.
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5 . 3 PCO DETA ILS TAB

Below the header on the PCO record, there are tabs for capturing the PCO’s details, costs, and
supporting documentation.

The PCO Details tab contains the identifying information you entered on the Assign to potential change
order window, along with a listing of the issues associated with the PCO, and the option to convert the
PCO to a CCO.

Title Description

1 PCO
navigation

Lets you navigate to other PCOs without having to go back to the PCO
log. Click the arrow to see a list of PCOs, and then select one. The
selected PCO opens in the same window.

2 PCO ID Free text entry field carried over from filling out the Assign to potential
change order window.

3 PCO Name Free text entry field carried over from filling out the Assign to potential
change order window.

4 Alternate ID Free text entry can be used as a subset to your PCO ID.

5 PCO start
date

The date that work on the PCO started. You can use a start date that is
different from the created date when the day work on a PCO was

Overview – PCO Details Tab
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Title Description

started is different from when the PCO was created. The PCO aging
days open column on the PCO log uses the start date instead of the
created date to give a more accurate count.

6 Description
of change

Free text entry for describing the PCO, carried over from filling out the
Assign to potential change order window. You can use the Expand icon
to expand the text box for easy text entry and viewing. You can then
collapse the text box when you are finished.

7 Change
orders

Clicking this link converts the PCO to a Client Change Order (CCO).

8 Additional
details

Sections for Schedule impact, Responsible parties, Correspondence,
Request for information, Tasks, Revenue category, Project values, and
Custom fields.

9 Associations l List of issues that were associated to the PCO for creation
l Click the ID-Name link to go back to the issue Details screen 
l Issue Details show the PCO ID for the issue the PCO is tied to
l Cost information is available in the Current value, Cost, Billing
Markup, Markup, Markup %, Deductions, and Net value columns

l Click the Add associated issue icon to add additional issues to
PCO if they are not assigned to an existing PCO or CCO

l You can also remove issues from the PCO from here

10 Potential
change order
terms

Terms specific to the PCO. You can add up to two terms. You can use
the Expand icon to expand the term text boxes for easy text entry and
viewing. You can then collapse the text boxes when you are finished.

11 eSign Lists of eSign recipients and Project contacts that default as signees for
an eSignature via a provider, such as DocuSign. When custom labels
are used for contacts in InEight Platform project details, Change uses
the labels in the Project contacts section. The labels are also used in
the Send for signature dialog box.

Overview – PCO Details Tab (continued)
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5.3.0 .1 eSign

The eSign section lets you view or add recipients to be used as default eSign signees. This section has
subsections for eSign and Project contacts. All signees must be added to at least one section.

l Names in the eSign section are populated from the project eSign setup tab (Project settings >
Change> Configurations > eSign setup). You can also manually enter the names of the signees.
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l Names in the Project contacts section are populated with contact information from project
contacts set at the suite administration level. This section is for reference only. If you want to
add or change recipients, you must edit the Project contacts section of the Project details.

5.3.1 Additional details

The Additional details section has expandable subsections for the following features:

l Schedule impact

l Responsible parties

l Correspondence

l Request for information

l Tasks

l Revenue category

l Project values

l Custom fields

5.3.1 .2 Schedule impact

The Schedule impact section includes the requested time extension. When there is only one issue
associated to the PCO, the issue delay days populates this field. When there is more than one issue
associated, the field is blank. You can add forecasted days in the Forecast field.

5.3.1 .3 Correspondence

Use the Correspondence section to track the following:

l PCO Date client notified. An information icon in the Date column shows the specific supporting
document that must be attached to populate the date. You can add the document on the
Supporting documents page. After a document is added, a link is shown in the File/Link column.

l PCO Date price to client. An information icon in the Date column shows the specific supporting
document that must be attached to populate the date. You can add the document on the
Supporting documents page. After a document is added, a link is shown in the File/Link column.

l PCO Client approval date. You can enter a client approval date.

l Executed change order. An information icon in the Date column shows the specific supporting
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document that must be attached to populate the date. You can add the document on the
Supporting documents page. After a document is added, a link is shown in the File/Link column.

5.3.1 .4 Request for in format ion

The Request for information fields are assigned by a supporting document of type RFI. The heading for
the Request for Information section includes a counter so you can quickly see the number of
associated RFIs the PCO has.

5.3.1 .5 Tasks

The Tasks section shows all tasks assigned in InEight Compliance for the PCO. For each task, the section
shows the task name with a link to the task, the name of the person assigned to the task, the due date,
and the current state. Overdue tasks show in red in both the Due date and State columns. Pending
tasks show in yellow in the State column. Completed tasks show in green in the State column.

5.3.1 .6 Pro jec t va lues

The Project Values section shows the project values configured for the project. For each project value,
you can select a value from the drop-down list. Each field has a Settings icon that takes you to the
Available project values page of the project. You can add project values or change the status of existing
project values with the applicable permission.

5.3.1 .7 Custom f ie lds

Custom fields include PCO custom lists 1 and 2 and PCO custom fields 1-4.

5 . 4 PCO PR IC ING TAB

Pricing for a PCO originates from its assigned issues. When you open a PCO, the Pricing tabs show the
values inherited from those issues, along with associated vendors and contracts. This automatic
inheritance of issue values occurs when the PCO is created.

The PCO includes two tabs for pricing:

l Pricing - Shows the inherited pricing details. Values on this tab are read-only.

l Pricing Summary - Shows pricing subtotals organized by cost pricing section, along with any
amounts entered as ROM, Estimate, Proposal, and Agreed values. Values from the Pricing tab are
displayed in the Estimate column and cannot be edited.

InEight Inc.  |  Release 25.9 Page 217 of 257

Change User Guide 5.4 PCO Pricing tab



5.4.1 Pricing tab

The Pricing tab shows the pricing established at the issue level. You cannot edit the inherited values on
this tab. You can only add an unassigned pricing item, if needed. To make detailed pricing updates,
return to the associated issue.

5.4.1 .1 Pr ic ing Summary tab

The Pricing Summary tab allows you to make lump-sum adjustments to the PCO total. When reviewing
or adjusting pricing here, keep in mind the following:

l Value precedence follows the same order as on issues:

l Estimate values take precedence over ROM .
l Proposed values take precedence over Estimate.
l Agreed values take precedence over Proposed.

l The PCO’s current value is the sum of the cost pricing sections including Labor, Equipment,
Materials, Vendor, and Time-related overhead totals.

5.4.1 .2 Update PCO values wi th issue values

If Change is not configured to automatically update value changes to higher levels, you can manually
update the PCO Pricing Summary tab with new pricing and associated vendor data from your issues.
Select Update values > Pull values from issue from the Actions menu.
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For example, you have a PCO with a total price of $10,210, totaled from Estimate values in the Pricing
summary on the PCO’s Pricing tab.

As your field engineer assesses things out in the field, he determines the estimate to be a little low, so
he changes one of the assigned issue’s Estimated subtotal to $12,000. You can update the PCO with
the new pricing by selecting Pull values from issue from the Actions menu.

You will receive a prompt asking if you are sure you want to update the PCO’s values. When you select
Yes, the PCO’s Estimate values update and the PCO’s new Grand total updates to $12,000.

Pricing changes made on the PCO do not change the pricing of the assigned issues.
Pricing changes made on the issue's Pricing Summary can only change pricing on the related
PCO if you select Update PCO values with issue values from the Actions menu, or you have
configured Change to automatically update value changes to higher levels. Values inherited
from the issue Pricing tab automatically update on the higher levels of PCO and CCO.

The ability to automatically update values from higher or lower levels is configured in project Settings >
Configurations > Pricing configuration. When set to automatically update value changes to higher
levels or lower levels, any changes made at the issue level are automatically reflected in the PCO. Any
changes made at the PCO level are automatically reflected in the issue and CCO.

When the Change is not configured to update values to higher levels, you can manually update values
as follows:

l At the issue level, you can push values to the PCO. If the PCO is associated to a CCO, the value is
automatically pushed to the CCO.

l At the PCO level, you can push values up to a CCO or pull values down to an issue.

l At the CCO level, you can pull values from the PCO. If the issue is associated with a PCO, the
value is automatically pulled from the issue.

When Change is not configured to update values to lower levels, you can manually update values as
follows:
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l At the issue level, you can pull values from the PCO. If the PCO is associated to a CCO, the value
is automatically pulled from the CCO.

l At the PCO level, you can push values to the issue or pull values from the CCO.

l At the CCO level, you can push values to the PCO. If the issue is associated with a PCO, the value
is automatically pushed to the issue.

If you make a change to the pricing at any level, the Pricing pages at the other levels show a banner
warning that the updated values are not reflected at all levels. For example, if a pricing change is made
at the issue level, the banner shows at the PCO and CCO levels. To update values, go to the Actions
menu. Then select whether to push values down or pull values up.

5 . 5 PCO LOG

On the Change page, the PCO Log tab contains a register of all your PCOs.

l Executed PCOs have a green checkmark next to them and are no longer editable

l Dropped PCOs have a yellow caution sign next to them and are locked

l Note that there is no delete button. Once a PCO is created, it cannot be deleted

l Many of the PCO details and statuses are editable from the Issue Log register

l The PCO Log provides subtotals at the bottom of the register for total number of PCOs and total
current values of the PCOs

By clicking the drop-down menu on the View box, you can change the viewsets of your table and can
save a custom view. You can also export your table (will export the data exactly as displayed within the
table), show details, and search for data within the table.
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You can generate a change document from the PCO log. Select a PCO, go to the Actions menu, and
then select Generate Change document. See 5.8 Change writer on page 236 for information about
generating change documents.

5.5.0 .1 Aging days

The number of days that a PCO has been open is shown in the PCO aging days open column. The Aging
days value is calculated using today's date minus the start date. This calculations stops when the item
is changed to a status of executed or dropped.

5 . 6 CL IENT CHANGE ORDER (CCO)
GENERAT ION

5.6.1 Overview

As you manage your issues and PCOs, you can convert them to Client Change Orders (CCOs) when they
reach any of the following criteria:

l You are finalizing the negotiating process with the client

l You have an agreement in place

l You have something up for signature or already signed

l You already know the final value of your change order
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5.6.2 Client Change Order (CCO) Creation

A CCO can be generated from an existing PCO, or directly from an Issue. The CCO will carry over all
pertinent data from the PCO/Issue and populate fields within the CCO. Just like the relationship
between issue and PCO, the link between Issue/PCO to the CCO is one-way, upstream. Data carried
over from the Issue/PCO into the CCO can be modified without any changes occurring to the former;
however, changes to the Issue/PCO can be pushed upstream to the CCO.

Create a Client change order (CCO)

Create a CCO when the change is finalized and ready to send to the owner.

When converting to a change order, an issue is limited to 250 unique cost items or 100 unique pay
items. If a message shows indicating that you must remove cost items or pay items, it is best practice
to create a new issue. Creating a new issue lets you create another change order with the removed
cost items and pay items.

1. From the PCO tab, select the PCOs you want to associate to a CCO, and then click the Associate
to Client change order icon..

The Associate to Client change order dialog box opens.

2. Indicate whether the PCO is to be associated to a new CCO or an existing CCO, and then enter
the CCO ID and CCO name. You can also enter an alternate CCO ID and a description of the
change.
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3. Click Save. The CCO Details page opens.

What's next: You can enter additional CCO details, manage pricing, and add supporting documents.

5.6.2 .1 Conver t to CCO from Issue/PCO Record

Another option for Converting to a CCO is on the Details tab of an issue record. Clicking the Assign to
potential change order link will open the window to assign the issue to a PCO.
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5.6.3 CCO Header

The header at the top of your CCO record contains the same functionality as the issue/PCO header,
allowing you to update the following:

l CCO status

l Pricing status

l Proposal status

5.6.4 CCO Details Tab

Below the header on the CCO record, there are tabs for capturing the CCO’s details, costs, and
supporting documentation.

The CCO Details tab contains the identifying information you entered on the Convert to client change
order window, along with several other fields to capture the change order amount, approved
extension information, and type of signing agreement.

Title Description

1 CCO
navigation

Lets you navigate to other CCOs without having to go back to the CCO
log. Click the arrow to see a list of CCOs, and then select one. The
selected CCO opens in the same window.

2 CCO ID Free text entry for describing the CCO, carried over from filling out the
Convert to client change order window.

3 CCO name Free text entry for the name of the CCO.

4 Alternate
CCO ID

Free text entry can be used as a subset to your CCO ID.

5 CCO start
date

The date that work on the CCO started. You can use a start date that is
different from the created date when the day work on a CCO was

Overview – CCO Details Tab
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Title Description

started is different from when the CCO was created. The CCO aging
days open column on the CCO log uses the start date instead of the
created date to give a more accurate count.

6 Description
of change

Free text entry for describing the PCO, carried over from filling out the
Convert to client change order window. You can use the Expand icon to
expand the text box for easy text entry and viewing. You can then
collapse the text box when you are finished.

7 Control
budget
change

Information about the contract adjustment status and the change
register ID from InEight Control.

8 Additional
Details

Sections for Client change order execution details, Schedule impact,
Responsible parties, Correspondence, Request for information, Tasks,
Revenue category, and Custom fields.

9 Associations l List of issues or PCOs that were associated to CCO for creation
l Clicking Issue or PCO ID link will navigate you back to Issue/PCO
record

l Cost information is available in the Current value, Cost, Billing
Markup, Markup, Markup %, Deductions, and Net value columns

l Able to add or remove issues or PCOs to the CCO if they are not
assigned to an existing CCO

10 Client
change order
terms

Terms specific to the CCO. You can add up to two terms. You can use
the Expand icon to expand the term text boxes for easy text entry and
viewing. You can then collapse the text boxes when you are finished.

11 eSign Lists of eSign recipients and project contacts that default as signees for
an eSignature via a provider, such as DocuSign. When custom labels
are used for contacts in InEight Platform project details, Change uses
the labels set at the suite administration level. The labels are also used
in the Send for signature dialog box.

Overview – CCO Details Tab (continued)
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5.6.4 .2 eSign

The eSign section lets you view or add recipients to be used as default eSign signees. This section has
subsections for eSign and Project contacts. All signees must be added to at least one section.
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l Names in the eSign section are populated from the project eSign setup tab (Project settings >
Change > Configurations > eSign setup). You can also manually enter the names of the signees.

l Names in the Project contacts section are populated with contact information from project
contacts added in Project details. This section is for reference only. If you want to add or change
recipients, you must edit the Project contacts section of the Project details.

5.6.5 Additional details

The Additional details section has expandable subsections for the following features:

l Client change order execution details

l Schedule impact

l Responsible parties

l Correspondence

l Request for information

l Tasks

l Revenue category

l Project values

l Custom fields

5.6.5 .3 Cl ient change order execut ion deta i ls

The Client change order execution section contains fields that are used when the CCO is executed.

The Signing agreement field describes how the CCO was executed (bilaterally, unilaterally, or
unassigned). The Current value is carried over from the Pricing tab and is read only. The executed
change order amount typically matches the Agreed Change Order Amount, but could differ due to
changes by the client. This value is shown in the CCO log.

The remaining fields are read-only and are automatically filled when the CCO is executed.

5.6.5 .4 Schedule impact

The Schedule impact section includes the Approved time extension and the Time extension. The
Approved time extension is the number of days granted by the client per CCO. You can also select
Deferred to defer the extension or N/A when the time extension is not applicable. The time extension
fields show the time extension requested. When there is only one PCO associated to the CCO, the PCO
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delay days populate this field. When there is more than one PCO associated, the field is blank. You can
add forecasted days in the Forecast field.

5.6.5 .5 Correspondence

Use the Correspondence section to track the following:

l CCO Date client notified - An information icon in the Date column shows the specific supporting
document that must be attached to populate the date. You can add the document on the
Supporting documents page. After a document is added, a link is shown in the File/Link column.

l CCO Date price to client - An information icon in the Date column shows the specific supporting
document that must be attached to populate the date. You can add the document on the
Supporting documents page. After a document is added, a link is shown in the File/Link column.

l Executed change order - An information icon in the Date column shows the specific supporting
document that must be attached to populate the date. You can add the document on the
Supporting documents page. After a document is added, a link is shown in the File/Link column.

5.6.5 .6 Request for in format ion

The Request for information fields are assigned by a supporting document of type RFI. The heading for
the Request for Information section includes a counter so you can quickly see the number of
associated RFIs the CCO has.

5.6.5 .7 Tasks

The Tasks section shows all tasks assigned in InEight Compliance for the CCO. For each task, the section
shows the task name with a link to the task, the name of the person assigned to the task, the due date,
and the current state. Overdue tasks show in red in both the Due date and State columns. Pending
tasks show in yellow in the State column. Completed tasks show in green in the State column.

5.6.5 .8 Pro jec t va lues

The Project Values section shows the project values configured for the project. For each project value,
you can select a value from the drop-down list. Each field has a Settings icon that takes you to the
Available project values page of the project. You can add project values or change the status of existing
project values with the applicable permission.

5.6.5 .9 Custom f ie lds

Custom fields include CCO custom lists 1 and 2 and CCO custom fields 1-4.
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5.6.6 CCO Pricing Tabs

On the CCO Pricing tabs, you can work out the final pricing for your change order, ending up with a
current value for the CCO derived from cost items and any assigned markups. You have the same
pricing functionality on the CCO Pricing tabs as you have on the PCO Pricing tabs.

5.6.6 .10 Pr ic ing tab

The Pricing tab shows the pricing established at the PCO and issue levels. It includes cost item pricing
including any unassigned pricing items and markups. You cannot edit the inherited values on this tab.
You can only add an unassigned pricing item, if needed. To make detailed pricing updates, return to
the associated issue.

5.6.6 .11 Pr ic ing Summary tab

The Pricing Summary tab shows subtotals organized by cost pricing section . You can make lump sum
adjustments to the CCO total.

l The Pricing summary has the same rules of precedence for ROM, Estimate, Proposal and Agreed
values.

l On the Pricing Summary tab, the Grand total is the sum of the Direct cost, Vendor, and Indirect
cost subtotals.

The ability to automatically update values from lower levels is configured in project Settings >
Configurations > Pricing configuration. When set to automatically update value changes to lower
levels, any changes made at the PCO level are automatically reflected in the CCO. Any changes made at
the CCO level are automatically reflected in the PCO.
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When the Change is not configured to update values to higher levels, you can manually update values
as follows:

l At the issue level, you can push values to the PCO. If the PCO is associated to a CCO, the value is
automatically pushed to the CCO.

l At the PCO level, you can push values up to a CCO.

l At the CCO level, you can pull values from the PCO. If the issue is associated with a PCO, the
value is automatically pulled from the issue.

When Change is not configured to update values to lower levels, you can manually update values as
follows:

l At the issue level, you can pull values from the PCO. If the PCO is associated to a CCO, the value
is automatically pulled from the CCO.

l At the PCO level, you can pull values from the CCO.

l At the CCO level, you can push values to the PCO. If the issue is associated with a PCO, the value
is automatically pushed to the issue.

If you make a change to the pricing at any level, the Pricing pages at the other levels show a banner
warning that the updated values are not reflected at all levels. For example, if a pricing change is made
at the issue level, the banner shows at the PCO and CCO levels. To update values, go to the Actions
menu. Then select whether to push values down or pull values up.

5.6.7 CCO Log

The CCO Log tab is a display of all CCOs, regardless of status. Most fields will contain data from the CCO
Details header and Pricing. However, there are some editable fields on within the CCO Log.

l Executed CCOs have a green checkmark next to them and are no longer editable

l Dropped CCOs have a yellow caution sign next to them and are locked

l Note that there is no delete button. Once a CCO is created, it cannot be deleted

l The CCO Log provides subtotals at the bottom of the register for total number of CCOs and total
current value of the CCOs (based on those CCOs that have locked pricing – ROM, Estimate,
Agreed)
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You can also export your table, show details, and search for data within the table.

When you export your table, the table exports the data exactly as it shows within the table; thus, if any
filters are on that data will not export. To export your table, click the Export icon from the toolbar.

You can generate a change document from the CCO log. Select a CCO, go to the Actions menu, and
then select Generate Change document. See 5.8 Change writer on page 236 for information about
generating change documents.

5 . 7 CL IENT CHANGE ORDER (CCO)
EXECUT ION

Once the change order is finalized with the client, you can change the CCO status to Executed.

An Executed change order document type must be uploaded as a supporting document prior to
changing CCO status to Executed.
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l When the CCO Status in the CCO Details Header is changed to Executed, the Close CCO and mark
complete window appears for final closeout of the change order

l When the CCO is closed, it is sent to the Change Register of InEight Control to make a contract
adjustment for cost, revenue, and man-hours, using the details and values entered in the CCO in
Change Management

5.7.1 Client Change Order Workflow Settings

With Client Change Orders you can turn on the workflow to send the CCO through an approval process
before execution is complete.  This is similar to the issue approval workflow. 

Once a CCO is completed (and workflow is turned on) the Submit CCO for approval button shows up in
the top left corner. 

Click the button to send an approval request to whomever is set up as the approver in the Project
Settings.  To get to the CCO Workflow settings go to Project Settings > Change > Workflow > CCo
Approval Setup and then turn on or off the approval step. 

Title Description

1 Agreed Change Order
Amount

Pulled from CCO Pricing Grand total.

2 Executed Change Order
Amount

l Free text entry pulled from CCO Details tab. The net
value is used by default.

l This is the value that will be pushed into the InEight
Control Change Register

3 Approved Time Extension l Drop-down selection menu; time extension granted by
client per CCO

l Shows in the CCO Log
l Defaults to 0 but can be changed

Overview – Close CCO and Mark Complete Window, Executed details
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Title Description

4 Approved Time
Extension

l Time extension granted by client per CCO
l Shows in the CCO Log

5 Signing Agreement l Used to indicate how the contract was executed, for
information only

l Bilateral - Both client and contractor
l Unilateral - Client or contractor only
l Unassigned

6 Notes Free text entry

Overview – Close CCO and Mark Complete Window, Executed details (continued)

Executed CCOs can be switched back to In Review with applicable permissions.

5.7.2 Executed CCO status

After a CCO is executed, the status changes to Executed in the Issue log, PCO log, and CCO log, and all
associated issues and PCOs are locked and cannot be edited, with the exception of a temporary
vendor. See Edit vendor information for information about editing a temporary vendor.

When a cost item is associated to an executed CCO, you can view details of the cost item by selecting it
and then clicking the Edit icon. The resources details and cost categories are shown but are read-only.
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5.7.3 Vendor change order creation

You can configure Change to automatically create a vendor change order (VCO) in InEight Contract for
any pricing items that are not already associated to a VCO. When the setting (Settings > Change >
Configurations > Pricing configuration > Vendor change order configuration) is set to Yes, Change
creates the VCOs upon execution of the CCO. You are prompted in the CCO Execution wizard to select
the vendor change order type. After the CCO is executed, the VCOs are in Contract with Service
Account as the Created by name. When the project setting is set to No, you must create the VCOs
manually in Contract.

Execute a CCO

Summary: Execute a CCO when the change order is finalized with the client.

Considerations: If the Vendor change order configuration setting in the project settings Configurations
(Settings > Change > Configurations > Pricing configuration > Vendor change order configuration) is set
to Yes, Change automatically creates a vendor change order from the executed CCO.

Quick steps:

1. From the CCO Log tab, select the change order.

2. Select the Supporting Documents tab.

3. Click the Add supporting documents icon, and then add a supporting document with the type
Executed change order

4. In the CCO header, change the CCO status to Executed. The Close CCO and mark complete
window opens.

5. Complete the required fields.
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6. Click Next.

7. Review and confirm the correct Executed Change Order document is attached to the CCO. If it is
not attached, you can attach it in the wizard.

8. Click Next.

9. Select the Vendor change order type for the pricing items that are not yet assigned to a VCO.
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10. Click Submit. Upon successful completion, the CCO is pushed to the Control change register.

What's next: If Change is configured to automatically create VCOs, the VCOs are created in Contract for
the pricing items. If Change is not configured to create VCOs, you can associate the CCO to a VCO in
Contract.

5 . 8 CHANGE WRITER

If you need to create a customized change document between the contractor, owner or
subcontractors, Change provides Change writer to aid in the development. This is a legal document
that needs to be signed by all parties and stakeholders. The Change writer supports both standard and
bulk template generation.

5 . 9 STANDARD AND BULK TEMPLATE
PROCESS ING

The Change writer lets you choose between standard and bulk processing.

Standard processing lets you choose between generating a merged PDF of all templates or individual
documents for each template. If you use standard processing with templates that include template
contact tags, you can choose one contact for a customized document.
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Bulk processing automatically generates a merged PDF document for up to 10 contacts in a single
action. The bulk templates feature works in conjunction with template contact tags, so you can
customize documents for up to 10 contacts, similar to a mail merge. You can use bulk processing for
generating multiple documents that include customized information for each contact, such as a cover
letter with a pricing request.

5 . 10 GENERATE A CHANGE DOCUMENT

When you are ready to create a change document, you can generate it from one or more templates.
Go to the Actions drop-down menu from any issue, PCO, or CCO, and then select Generate change
document to start the Change writer wizard. The Change writer wizard supports standard or bulk
processing.

Generate a standard change document

1. From an issue, PCO or CCO, select the Actions menu drop-down list, and then select
Generate change document from the menu. You can also find this option in the Actions
menu on the PCO and CCO logs. Select a PCO or CCO, and then go to the Actions menu.

l The Change template opens to show the assigned templates to your project.
l Templates for lower levels are available. For example, if you are in a PCO, templates
for PCO and issue are available. When you use an issue or PCO template type at a
higher level and choose to generate the document as individual documents, Change
generates a separate document for each issue or PCO.

2. Move one or more templates from the Available templates column to the Selected templates
column.
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Use the up and down arrows to the right of the Selected templates column to change the order
of the templates, if needed.

3. In the Change template details section, select the Standard template generation type.

4. Select one of the following in the Generate document as field:

l Individual documents to get a separate document for each template you selected.

l Merged document (PDF only) to merge the templates into a single PDF document.

5. If you selected Individual documents in the previous step, use the Generate document file type
as field to indicate whether to download as a template file type or download as a PDF. If you
selected Merged document in the previous step, skip this step.

6. Use the toggle to indicate whether to save the contract document in the Supporting documents
tab.

If you choose to save in the Supporting documents tab, add the name of the document. After the
document is generated, the name shows in the Title and the File/Link columns on the Supporting
documents register.

7. Select the watermark text. If the organization-level settings require a document, the Select
watermark stamp field is required. Also, if the organization-level settings require a watermark
and the end watermark event has not occurred, the Select watermark stamp field is required. If
the end watermark event has occurred, the watermark is optional.
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8. Click Next.

9. If Change writer detects a template contact tag, processing moves to the Select contact step. If
no template contact tags are detected, the Change document wizard skips this step and moves
to the Review fields step.

l Select one contact from the contact list, and then click Next. Processing moves to the
Review fields step.

l If no contacts have been configured in the project contacts, this step is disabled. You can
either go back, so you can remove the templates that have template contact tags, or
cancel.

10. On the Review fields step page, expand to Review templates page to see a list of all templates
used. If you specified a contact, the contact name is also shown. The review dialog box lets you
edit or add information to the fields that will populate the document after it is generated. Any
field that is blank is not added to the document, and you cannot add information later.

11. Review the fields and enter any information in the fields that apply to your issue. When you use
an issue or PCO template type at a higher level and choose to generate the document as
individual documents, Change generates a separate document for each issue or PCO. When you
choose to merge the document into a single PDF, the document uses the template for each issue
and merges it into the single document. When you review the templates, the project name and
the fields are repeated for each issue.

InEight Inc.  |  Release 25.9 Page 239 of 257

Change User Guide 5.10 Generate a change document



The <<Blankn>> tag, where n is a value in the range 1-15, shows in the downloaded tag list. The
tag serves as a placeholder in your template where the text can be entered to appear in the
fields when you review the template. When you generate the Microsoft Word document, the
text is replaced with what you entered in the review. You must enter text each time you
generate the Word document. If you do not enter values in the Review fields, the <<Blankn>>
tag is shown in the Word document.

12. After you have reviewed all changes, you can see a preview of your document by clicking the
Preview document button. The preview opens in a separate window with the tags filled in. If you
used collection tables in any of your templates you cannot view them in the preview document.
The content of the preview varies as follows:

l If you selected Download as a PDF document when you generated the document, the
preview contains all of the templates in the order you specified.

l If you selected Download as individual documents when you generated the document, the
preview contains only the template that was displayed when you clicked Preview
document. You can preview other documents by selecting the file from the Review
templates list and clicking preview document.

13. Click Finish. If you use templates from other levels, multiple completion messages are shown.

14. If you created a merged document, Change writer downloads a PDF that includes all of the
templates. If you created individual documents, Change writer downloads a PDF for the selected
template only.

Generate a change document using bulk template processing

You can use bulk template processing when you want to generate separate change documents in a
single action. When used in conjunction with templates that contain template contact tags, you can
customize a document for each specified contact.

If you want to generate customized documents, you must include a template that has template contact
tags. Contacts must be assigned in the project's Assigned contacts (project > Assigned contacts).

1. From an issue, PCO or CCO, select the Actions menu drop-down list, and then select
Generate change document from the menu. You can also find this option in the Actions
menu on the PCO and CCO logs. Select a PCO or CCO, and then go to the Actions menu.
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l The Change template opens to show the assigned templates to your project.
l Templates for lower levels are available. For example, if you are in a PCO, templates
for PCO and issue are available. When you use an issue or PCO template type at a
higher level and choose to generate the document as individual documents, Change
generates a separate document for each issue or PCO.

2. Move one or more templates from the Available templates column to the Selected templates
column.

Use the up and down arrows to the right of the Selected templates column to change the order
of the templates, if needed.

3. In the Change template details section, select the Bulk template generation type.

4. Use the toggle to indicate whether to save the contract document in the Supporting documents
tab.

If you choose to save in the Supporting documents tab, add the name of the document. After the
document is generated, the name shows in the Title and the File/Link columns on the Supporting
documents register.
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5. Select the watermark text. If the organization-level settings require a document, the Select
watermark stamp field is required. Also, if the organization-level settings require a watermark
and the end watermark event has not occurred, the Select watermark stamp field is required. If
the end watermark event has occurred, the watermark is optional.

6. Click Next.

7. If Change writer detects a template contact tag, processing moves to the Select contact step. If
no template contact tags are detected, the Change document wizard skips this step and moves
to the Review fields step.

l Select up to 10 contacts from the contact list, and then click Next. Processing moves to the
Review fields step.

l If no contacts have been configured in the project contacts, this step is disabled. You can
either go back, so you can remove the templates that have template contact tags, or
cancel.

8. On the Review fields step page, expand to Review templates page to see a list of all templates
used. If you specified contacts, the templates are listed for each contact name.
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Click each template to review the information. The review dialog box lets you edit or add
information to the fields that will populate the document after it is generated. Any field that is
blank is not added to the document, and you cannot add information later.

9. Review the fields and enter any information in the fields that which apply to your issue. When
you use an issue or PCO template type at a higher level and choose to generate the document as
individual documents, Change generates a separate document for each issue or PCO. When you
choose to merge the document into a single PDF, the document uses the template for each issue
and merges it into the single document. When you review the templates, the project name and
the fields are repeated for each issue.

The <<Blankn>> tag, where n is a value in the range 1-15, shows in the downloaded tag
list. The tag serves as a placeholder in your template, so text can be entered in the fields
when you review the template. When you generate the Microsoft Word document, the
text is replaced with what you entered in the review. You must enter text each time you
generate the Word document. If you do not enter values in the Review fields, the
<<Blankn>> tag is shown in the Word document.

10. After you have reviewed all changes, you can see a preview of your document by clicking the
Preview document button. The preview opens in a separate window with the tags filled in. If you
used collection tables in any of your templates you cannot view them in the preview document.
The preview contains all of the templates in the order you specified.

11. Click Finish. If you use templates from other levels, multiple completion messages are shown.
Change writer downloads a PDF that includes all of the templates.
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5 . 11 SUPPORT ING DOCUMENTS

The PCO and CCO Supporting Documents tabs let you add supporting documentation. You can upload
documentation via a file, link or through InEight Document integration.

Supporting documents can be uploaded via a file or through InEight Document integration. At the PCO
level, no supporting documents are required, however it is a best practice to include all documents
relating to the PCO. At the CCO level, an executed change order must be attached before the CCO
status can be changed to Executed.

You add supporting documents by clicking the Add icon on the PCO or CCO Supporting Documents tab.
You have the choice of adding a new supporting document or adding a document from InEight
Document.

When you choose New supporting document, you can add the appropriate documents as needed by
filling out the Title and Document type in the Add supporting document dialog box, then browsing to
your document file and attaching it. When the document is added from InEight Document, and the
document type in Document matches a document type in the cloud platform, that value shows as the
default document type. You can edit the document type as needed.
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When you choose From InEight Document, you are taken to the Document login window.

When you add a supporting document type of Proposal and subtype From vendor, you can select a
vendor from a list of all contracts on the PCO or CCO. This lets you specify which contract the
supporting document is related to and gives visibility into which contract to associate the proposal to.

5.11.0 .1 Show suppor t ing documents in generated documents

A toggle on the Supporting documents register, Show in generated document, lets you indicate
whether the document is shown in a collection table based on the collection table type. When you
have a supporting document that you do not want to show in a collection table in a generated
document, set the toggle to No. When a document is generated, only the documents that were set to
Yes are shown.
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5 . 12 V IEW A SUPPORT ING DOCUMENT

To view a supporting document, click the link in the File/Link column of the Supporting documents
register. The document opens a preview in a new tab, so you can view the pages of the document and
then decide if you want to download it to your workstation. You can use the Previous and Next
buttons to view all pages.

To download the document to your workstation, click Download file.
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5 . 13 SEND CHANGE DOCUMENTS FOR
ES IGNATURE V IA DOCUS IGN

When a project is integrated with DocuSign, you can send a change document to DocuSign for an
eSignature.

DocuSign tags can be embedded in the change document template. The DocuSign tags correspond to
DocuSign recipients configured in the project settings and project contacts.

Send a document for eSignature

After a document has been created, you can send it for official eSignatures via DocuSign.

Documents must be in Word, Excel, or PDF format. They must be saved to the PCO or CCO supporting
documents page with the document sourceMy computer. You must have Edit change document
permissions to send documents. Ensure that your browser's pop-up blocker is disabled before you click
Send from the Contract DocuSign wizard. You must have the Send for eSignature permission to send a
document for signature.

1. From the PCO or CCO Supporting documents page, select one or more documents with the
document sourceMy computer, and then click the Send for signature icon.

The Send for signature wizard opens.

2. Review the Names in the Assigned section of the wizard. If you want to add additional recipients,
find their names in the Unassigned section, and then click the Add icon. All signees in the
Assigned section have ad-hoc signee tags that can be placed on the document in DocuSign.
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3. For each assigned recipient, specify in the Action column whether they need to sign the
document or if they are just to receive a copy. When the value is Needs to sign, the recipient
receives a document that is ready to sign. When the action is Receives a copy, the recipient
receives a snapshot of the document in the signing order. For example, if the recipient marked
Receives a copy is second in the signing order, they receive the document after those first in
signing order, even though they are not signing.

4. Review the values in the Signing order column. The numbers in the column specify the order in
which the recipients are sent the document for eSignature. You can assign a single number to
multiple signees. The signee or signees with signing order 1 are notified first by DocuSign. After
all signees in signing order 1 have signed, DocuSign notifies all signees with signing order 2, and
so on.

5. Click Next. The Add message page opens.

6. Enter an email subject line and message to the recipients, and then click Send. A DocuSign
window opens with the documents you chose.

If the DocuSign window does not open, ensure that your browser's pop-up blocker is
disabled.

Page 248 of 257 InEight Inc.  |  Release 25.9

5.13 Send Change documents for eSignature via DocuSign Change User Guide



7. If your DocuSign administrator has configured Advanced Options, you can optionally expand the
Actions menu, and then select Advanced Options.

You can then customize the following options:

l Branding – Select a logo and brand colors, that were set up by the DocuSign administrator,
for the envelope.

l Recipient privileges – Give recipients options for how they sign the document, such as
signing on paper, assigning delegates, and editing documents.

l Reminders – Specify whether DocuSign sends reminders to signees, when to start sending
them, and how often to send them.

l Expiration – Set the number of days until the envelope expires and how often to send
alerts.

l Comments – allow senders and recipients to enter comments on documents in the
envelope.

Click Save. You are returned to the document.

8. Optionally, add additional tags for signatures, initials, and dates. All names from the Assigned
section of the wizard are shown in a drop-down list in the upper left pane. Select the name of
the person you want to add, and then select Signature, Initial, or Date Signed, and then click the
location in the document.
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9. If the document has tags for a text box, drop-down list, check box, or radio buttons, add the
values to the document. Click Send.

The documents are routed for signature, and DocuSign sends an email message to each recipient
based on the signing order. In Change, the DocuSign status column on the Supporting documents page
is populated with the status of Sent. You can hover over the status to see the name of the person who
sent the document, the status of the signatures, and the date and time the document was last
modified. The Change writer automatically adds the sender to the last position of the list with the
action Receives a copy. After it is completed, the signed document is loaded as a supporting document
with a document type Signed document, and the sender also receives a copy.

When a supporting document has a DocuSign status of Created, Completed, or Signed, you can no
longer edit the file link. When the status is Sent, you can edit the document in the original eSign
envelope without incurring the expense of additional envelopes.

Edit a sent document

You must have the Correct eSignature permission to correct DocuSign documents.

1. On the Supporting documents register, hover over the ellipsis in the DocuSign status column for
a sent document. The DocuSign Status dialog box is shown.
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2. Click the Correct button. DocuSign opens with the view of the original envelope.

Make the corrections in the DocuSign envelope. Refer to DocuSign documentation for more
information about envelopes.

5 . 14 DOCUS IGN CERT IF ICATE OF
COMPLET ION

After signing is completed, the certificate of completion is now available when you hover over the
ellipsis in the DocuSign status field in Supporting documents.

The View certificate of completion link becomes available after a document is completed. The
certificate of completion is stored in Supporting documents, but it does not take up a separate entry in
the Supporting documents register. The certificate does not expire in Change.

When you click View certificate of completion, a preview of the certificate from DocuSign opens in a
new tab. You have the option to download the file if you want to store it separately.

InEight Inc.  |  Release 25.9 Page 251 of 257

Change User Guide 5.14 DocuSign certificate of completion



5 . 15 WORKFLOW ASS IGNMENTS

Each PCO and CCO is unique and might require various levels of approval for the PCO, CCO, or
supporting documents. The Workflow Assignments tab lets you to set up the proper approval steps.
Workflow approvals are assigned at the organization, project, and PCO or CCO levels to allow for
maximum flexibility in the approval workflow.

5.15.1 PCO and CCO workflows

Workflows configured at the organization or project level are based on value thresholds. The
thresholds are absolute values. When the change order reaches a value above or below the specified
threshold, a user or role must approve the change order before it can advance. For example, if the
threshold is $1000, a change of $1000 or -$1000 or more starts the workflow.

You can configure approval workflows for any PCO or CCO. These approval steps are first in the
approval workflow. If the difference in value of the PCO or CCO is greater than absolute value
workflow thresholds set at the organization or project levels, the approval steps are shown on the
page. They are marked with the information icon. Any steps you add are performed before those set at
the organization and project levels. When the value of the PCO or CCO is within the absolute value
thresholds or if no thresholds have been set, only the steps at the PCO or CCO level are performed.

A PCO does not need to be fully approved before converting it to a CCO. When you convert a PCO that
has not been fully approved to a CCO, the PCO approval status is shown in the new Approval status
field in the Associations section of the CCO details. You must complete all of the PCO approval steps
before you can start the CCO approval workflow. The CCO must be approved, if required, before it can
be submitted for execution.

Set up a PCO or CCO approval workflow

Set up an approval workflow for a PCO or CCO when the change order requires approval by various
levels of your organization before it can advance.

Steps set at the PCO or CCO level are performed before those set at the project and organization
levels, respectively. If the value difference of the PCO is greater than the absolute value thresholds, the
steps are shown on the Workflow approvals page, and you cannot rearrange or delete them.
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1. On the record page for a PCO or CCO, select theWorkflow Assignments tab.

2. Click the Add approval icon. The Add approval slide-out panel opens.

3. Enter an approval step title, and then specify the users, groups, or roles who must give their
approval.

4. Click Add.

5. Repeast steps 3 and 4 until all approval steps are added. You can use the up and down arrows to
change the order of the steps you added, if necessary. Click Save after rearranging the approval
steps.

When the change order is ready to advance, you can start the approval workflow.

Start the approval workflow

Start the approval process when the PCO or CCO is complete and you are ready to advance to the next
stage.

1. Go to the Details page for the PCO or CCO, and then click Save and start approval. The Start
approval dialog box opens to the approval steps page.

2. Review the change approval steps.

3. Choose one of the following:
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l If you do not want to add a message and attach supporting documents, click Start. The
approval process starts.

l If you want to add a message or attach supporting documents, click Next. The Add
messages page opens.

4. Choose one of the following;

l If you want to add a message to be included in the workflow email, type and format it, and
then click Next. The Attach supporting documents page opens.

l If you do not want to add a message, click Next. The Attach supporting documents page
opens.

5. Choose one of the following:

l If you want to attach supporting documents, click Next. The Attach supporting documents
page opens.

l If you do not want to attach supporting documents, click Start. The approval process
starts.

6. Select one or more supporting documents from the list of documents.

7. Click Start. The approval process starts.

The approvers receive a notification of the approval item. When you start the approval process and
you are the first approver in the approval workflow, the first step of the workflow is automatically
approved, and the workflow continues with the next step, if applicable. If you are the only step in the
approval, you receive a second email confirming the new issue has been approved.

5.15.2 Document approval workflows

Document approval workflows are based on document type. Document approval workflows are set up
at the organization and project levels. At the change order level, you can set up additional document
approvals on the Document approval page of the Workflow assignments tab.
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Set up a document approval workflow

Set up a document approval workflow when a document associated with change order requires
approval by various levels of your organization before it can advance.

Approval steps might have been set at the organization or project levels. You cannot rearrange or
delete the approval steps; you can add steps that are performed before those set at the project and
organization levels.

1. On the record page for a PCO or CCO, select theWorkflow Assignments tab, and then select the
Document approval setup tab.

2. Click the Add approval icon. The Add approval slide-out panel opens.

3. Select a document type. If there are already approval steps for a document type, it is not shown
in the drop-down list.

You can add steps to an existing approval by canceling this set up and then clicking Add
another step for the document type.

4. Enter an approval step title, and then specify the users, groups, or roles who must give their
approval.

5. Click Add.

6. Repeat steps 2 - 4 until all approval steps are added. You can use the up and down arrows to
change the order of the steps you added, if necessary. Click Save after rearranging the approval
steps.

When the change order is ready to advance, you can start the approval workflow.
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Start the document approval workflow

Start the approval process when the document is complete, and you are ready to advance to the next
stage.

1. Go to the Supporting documents page for the PCO or CCO, and then select one or more
documents.

2. Click Start approval. The Start approval dialog box opens. The Start approval dialog box shows all
the steps in the approval workflow for each document selected.

3. Review the change approval steps for each document. If there are group steps, you can select
the group for the workflow. If you want to make changes to the approval process, click Cancel,
and then go to the Workflow Assignments tab to make your changes. If the steps do not require
changes, click Start. The Start approval dialog box stays open until all workflows have
successfully started.

If you are an approver, you receive a notification of the approval item. Each approval workflow
generates its own mail notification to the first approver. When you start the approval process and you
are the first approver in the approval workflow, the first step of the workflow is automatically
approved, and workflow continues with the next step, if applicable. If you are the only step in the
approval, you receive a second email confirming the new issue has been approved.

When the document is in approval, you can change the supporting document title or add or change
notes and other metadata. You cannot change the document type or the file link. If you want to
change the file link or the document type, you must recall the document from the approval, make the
changes, and then start the approval again.

You can view document approval workflow progress and history on the project Workflows >Workflow
details page. If the workflow has been recalled, the name of the person who recalled the workflow is
shown in the workflow heading.

5 . 16 AUD IT LOG

The Audit Log captures all changes made to issues, Potential Change Orders, and Client Change Orders.
The CCM ID and Name/Description columns contain hyperlinks that if clicked will open the
issue/change order for your review.

The Log shows the Value before and Value after the change and displays who made the change and
when.
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